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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product value 
chain. 

Audience
This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My 
Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle 
Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html contains 
the latest versions of the Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation 
(PDF) files. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an 
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which 
you supply particular values.
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monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter.

Convention Meaning
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1Introduction

This guide describes how to install the Agile e6.2.1.0 server on all supported operating systems 
- Windows and UNIX.

If the information varies between Windows and UNIX, a note is added to point out the 
differences.

Installation Components
Possible installation components:

? Oracle Database Server 64-Bit 
(Refer to Platform Support for Agile e6.2.1.0 document for supported version)

? Oracle Database Client 32-bit 
(Refer to Platform Support for Agile e6.2.1.0 document for supported version)

? Oracle WebLogic Server 
(Refer to Platform Support for Agile e6.2.1.0 document for supported version)

? Agile e6 Server (always referred to as EDM Server)

The following table shows the different options to install the necessary components with the 
Agile e6 installer.

The following table gives an overview of the installation components, their necessary 
requirements, and Windows / UNIX support.

Note: The information in this document will always refer to Windows first, 
then to UNIX.

Note: With the Agile e6 installer, every component has to be installed 
separately.

Note: The installation scenarios in this document are assuming that Oracle 
WebLogic Server and EDM Server will be installed on the same machine.

In case of installing the Oracle WebLogic Server and the EDM Server on 
different machines, please refer to the chapter Component Based Installation.
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Syntax in Entire Document

Note: Before installing Agile e6, make sure that you meet all installation 
prerequisites, including required operating system maintenance level fixes, 
and system patch levels, mentioned in the Prerequisites Guide for Agile 
e6.2.1.0

Installation 
Component Requirements for Windows and UNIX

Agile e6 Installer 
Support

Windows UNIX

Oracle Database Server  None

 The Oracle Database Server can be installed 
independently

Yes No

Oracle Database Client  After the Oracle Database Client is installed, 
the SQLnet has to be configured

Yes No

Oracle WebLogic 
Server

 The installation source file (e.g. fmw_
12.2.1.3.0_wls.jar) has to be available on the 
hard disk, before installing the Oracle 
WebLogic Server with the Agile e6 Installer.

 After the Oracle WebLogic Server is 
installed, the Node Manager has to be 
configured.

Yes No

EDM Server  The Oracle Database Server has to be 
installed and running

 The Oracle Database Client 32-bit has to be 
installed locally.

 The Oracle WebLogic Server has to be 
installed locally, with a running Node 
Manager.

Yes Yes

Agile e6 File Server  None

 The Agile e6 File Server can be installed 
independently.

Note: The Agile e6 File Server is usually 
installed on a different machine than the 
EDM Server.

Yes Yes

Note: Do NOT install on an existing EDM Server on Windows that is in 
use.

Description Example

Path Names The path name on a Windows operating system 
contains backslashes '\'.

C:\Windows\system32

The path name on a UNIX operating system contains 
slashes '/'.

/usr/bin

Environment Variables The environment variable on a Windows operating 
system has to be placed between two percent '%' 
characters.

echo %ORACLE_
HOME%
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The environment variable on a UNIX operating 
system has to be placed after a dollar '$' character.

echo $ORACLE_
HOME

OR:

echo ${ORACLE_
HOME}

Description Example
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2Preparing the Installation

Download
Download and extract the necessary software packages from the Oracle Software Delivery 
Cloud https://edelivery.oracle.com/ or from Oracle Support (http://support.oracle.com).

? Oracle Agile Engineering Data Management Application (Release e6.2.1.0) Media Pack 
delivered by Oracle on the Oracle Software Delivery Cloud https://edelivery.oracle.com/.

Open the file and extract it. This will create the directory Agile_e6210. This directory is later 
referred to as the <installation-media-path>.

? Oracle Database Sever installation from Oracle Software Delivery Cloud 
(https://edelivery.oracle.com). The installation source has to be unpacked on the hard disk 
first.

? Oracle Client Release (32-bit) from Oracle Software Delivery Cloud 
(https://edelivery.oracle.com). Please select the related 32-bit operation system. The 
installation source has to be unpacked on the hard disk first.

?  WebLogic media pack (Standard or Enterprise Edition depending on your licenses) 
delivered by Oracle on the Oracle Software Delivery Cloud https://edelivery.oracle.com/.

Note: On UNIX, the unzip program has to be used to preserve all 
executable permissions while extracting the zip archive. Using ${JAVA_
HOME}/bin/jar -xf <filename> to extract the zip archive will not preserve the 
executable permissions of the installation scripts. They will also be lost if the 
zip archive was extracted on a Windows system and then transferred to a 
UNIX system, or installed directly from a Windows share.

Note: The 32-bit Oracle Client must be installed on the machine where 
Agile e6.2.1.0 is installed

Note: For further information about the Oracle Database, please refer to the 
chapter Installing Oracle Database Server.
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Further Preparation Steps

Windows
To complete all installation tasks, the cmd shell has to be started.

To open the cmd shell with "Run as administrator", do the following:

1. Select Start > All Programs > Accessories > Command Prompt.

2. Select Run as administrator from the context menu.

The User Account Control Window appears.

3. Apply the needed credentials if asked, and select Yes/Continue to go ahead.

The Windows cmd shell appears. This is the shell you have to use for all installation tasks.

UNIX
There are no special permissions required for starting the installation.

Enable Trace (optional)
If you want to have detailed trace messages for your GUI installation, the following 
environment variables have to be set:

Windows

? set plm_ant_loglevel=4

? set plm_ia_stderr=C:\temp\iastderr.log

? set plm_ia_stdout=C:\temp\iastdout.log

 UNIX:

? setenv plm_ant_loglevel 4

? setenv plm_ia_stderr ${HOME}/temp/iastderr.log

? setenv plm_ia_stdout ${HOME}/temp/iastdout.log

Note: Always start the cmd shell with "Run as administrator", even if you 
are doing the installation as the Administrator User.

Note: Please be prepared, that at the end of the Oracle Database or Oracle 
WebLogic installation, special permissions to execute the scripts as the root 
user might be requested.

Note: Do not use the root user to install any components.

Note: The path to the log files has to exist and the installer directory is 
writeable by the user who starts the installation.



Further Preparation Steps

Preparing the Installation 2-3

Oracle Database
For complete information on Oracle Database, refer to the Oracle Database Documentation 
Library at 

https://docs.oracle.com/en/database/oracle/oracle-database/index.html

WebLogic Server
For complete information on Oracle WebLogic Server, refer to the Oracle WebLogic Server 
Documentation Library at 

https://docs.oracle.com/en/middleware/index.html

https://docs.oracle.com/en/middleware/index.html
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3Installation with the Agile e6 Installer

This chapter describes the installation with the Agile e6 Installer to install the Agile e6 Client, 
Oracle Database, Oracle WebLogic Server, and EDM Server.

Starting the Agile e6 Installer

1. Start a command shell.

? Windows

a. Open an Administrative command shell and change to the installer directory: 
<installation-media-path>\installer.

cd <installation-media-path>\installer

b. Set the JAVA_HOME environment variable to the installed Java Development 
Kit. This has to be a 64-bit Java 8 Development Kit.

set JAVA_HOME=C:\Program Files\Java\jdk1.8.0_<update_number>

c. Start the installer from the command shell with the following command:

gui.cmd

? UNIX

a. Open a command shell and change to the installer directory 
<installation-media-path>/installer.

cd <installation-media-path>/installer

Note: Some of the values entered in the following screens will be validated, 
either while entering the values or after pressing the "Next" button. If the 
validation fails, the text color is displayed in red, or a message containing the 
error is displayed. First the error has to be corrected before you can proceed!

The input for TCP port numbers is limited to the range 1024 - 65535.

The WebLogic passwords must be between 8 and 20 characters long, and is 
limited to the following characters:

? Lower or upper-case alphabetic characters: a-z A-Z

? Decimal digits: 0-9

? Space

? One of the following characters: !"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
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b. Set the JAVA_HOME environment variable to the installed Java Development 
Kit. This has to be a 64-bit Java 8 Development Kit.

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>

c. Start the installer with the following command:

./gui.csh

2. The Installation Sets screen is opened.

3. Select an Installation Set.

Depending on the selected installation, see the following sections for more detailed 
information:

? Oracle Database

? Oracle WebLogic Server

? Agile e6 Server

Oracle Database

Note: UNIX

Only the "Agile e6 Server" set is available on a UNIX operating system.

Note: The Agile e6.2.1.0 client installation is described in the Client 
Installation Guide on Windows for Agile e6.2.1.0.
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1. Select Oracle Database and click Next.

The Installer Components screen is opened.

2. Select the component which should be installed and click Next.

If you selected only the Database Client Software, then the following screen is opened.

Note: This section is not available on a UNIX operating system. Please see 
Chapter 7, "Installing Oracle Database Server" for the manual installation of 
the Oracle Database.

Component Description

Database Server Software Installs the Database Server Software and performs the instance setup.

Database Client Software Installs the 32-bit Database Client Software.

This is required on the machine where the EDM Server will be installed.

Note: It is possible to install either the Server or the Client Software. 

Note: The Agile e6 GUI installer supports the installation of the Database 
Server - Enterprise Edition only. For the Standard Edition 2 follow the 
description in Chapter 7 "Installing Oracle Database Server"
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If you selected only the "Database Server Software", then the following screen is opened.

Setting Description

Source 32-bit Client The source of the 32-bit Oracle client installation media.

Source 32-bit Client Patch The source of the 32-bit Client patch installation media

Oracle Base The ORACLE_BASE directory where you want to install the Oracle 
client.
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Oracle Database Software Section

Oracle Database Instance Section

Setting Description

Source The source of the 64-bit Oracle database server installation media.

Oracle Base The ORACLE_BASE directory where you want to install Oracle or where the instance 
(e.g. for Oracle 12cR1 the path should look like "C:/oracle") should be created.
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3. Define the configuration options and click Next.

The Oracle Database installation starts.

Setting Description

Oracle Data1-5 The Oracle database files can be stored on up to 5 disks. If you have less than 5 
disks, put more data files on the same disks. Under the selected directory, the 
directory "oradata/<SID>" will be created (e.g. you selected "c:/oracle/oradata1" 
the db files will be placed in "c:/oracle/oradata1/oradata/plm62")

Oracle Data1: CONTROL01.CTL, EDB_LOB01.DBF, EDB_TMPIDX01.DBF, 
EDB01.DBF

Oracle Data2: CONTROL02.CTL , EDB_IDX01.DBF, EDB_TMP01.DBF

Oracle Data3: CONTROL03.CTL, TEMP01.DBF

Oracle Data4: UNDOTBS01.DBF

Oracle Data5: SYSAUX01.DBF, SYSTEM01.DBF, TOOLS01.DBF, 
USERS01.DBF

Redo Log 1-2 The 2 sets of the database Redolog files will be stored on two disks.

1. On location Redolog1

2. The copies on location Redolog2.

Under the selected directory, the directory "oradata/<SID>" will be created (e.g. 
you selected "c:/oracle/oradata1" the database files will be placed in 
"c:/oracle/oradata1/oradata/plm62").

SID The SID of the instance.

Listener Port The port of the listener (default is 1521).

Enterprise Manager 
Port

The port number of the Oracle Enterprise Manager Database Express (default is 
5500).

Database Size Depending on how big the database dump is, different values can be selected.

Note: Further information can be found in the Hardware Sizing Guide for Agile 
e6.2.1.0.

Archive Mode True:

Activates the archive mode of the database (mandatory for production usage).

False:

Does not activate the archive mode for the database.

Archive Logs Destination of the archive log files.

Processes Depending on how many users will connect to the application, an appropriate 
value has to be applied here.

Processes must be set to at least a number calculated with following formula: 

number of concurrent user * 2 +50. 

Depending on your application setup values can be higher.

Note: Further information can be found in the Hardware Sizing Guide for Agile 
e6.2.1.0.

SYS Password The password which should be used for the Oracle SYS user.

Verify Password The password entered above has to be repeated for verification.

System Password The password which should be used for the Oracle SYSTEM user.

Verify Password The password entered above has to be repeated for verification.
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Oracle WebLogic Server

1. Manually update the property file "iconstants.properties" in Agile e6.2.1.0 GA installer 
(<installation-media-path>\installer\properties directory) by either one of the following 
ways: 

? Modify the first line as described below 

– For Weblogic 12.2.1.3

PLM_INSTALLER_ORACLE_WLS_VERSION=12.2.1.3.0

– For Weblogic 12.2.1.4

PLM_INSTALLER_ORACLE_WLS_VERSION=12.2.1.4.0

? Copy iconstants.properties file from <RUP_Installer>\pkg\installer\properties 
directory to overwrite the old one under <installation-media-path>\installer\properties 
directory

2. Select Oracle WebLogic Server and click Next.

The Standalone Components Configuration screen is opened.

? Screen on Windows.

Note: Database Pump will not be configured during the automatic 
installation. Please see the Create Directories for the Oracle Data Pump 
Utility section in Chapter Post-Installation Modifications for the Oracle 
Database.

Note: This section is not available on a UNIX operating system. Please see 
Chapter 10 “Installing Oracle WebLogic Server” for the manual installation 
of the Oracle WebLogic Server

Note: The 64-bit Java 8 has to be installed before starting the Oracle 
WebLogic Server installation.

Note: The certified JDK for Oracle WebLogic 12.2.1.4 is jdk1.8.0_211 (it 
has to be 64-bit) or higher version. We recommend use latest JDK version.
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3. Define the component configuration options and click Next.

The WebLogic installation starts.

4. The WebLogic Node Manager has to be configured manually after the installation is done. 
See also section Node Manager Configuration in chapter Installing Oracle WebLogic 
Server.

Agile e6 Server

1. Select Agile e6 Server and click Next.

The Installation Mode screen is opened.

Setting Description

Source The full path to the installer of the WebLogic server (e.g. fmw_12.2.1.3.0_wls.jar)

Java Home Java 8 64-bit home directory which will be used for the installation and development of 
the WebLogic Server.

Oracle Home 
(WebLogic)

The Oracle Home where you want to install WebLogic, e.g.:

 Windows

D:/Oracle/Middleware/Oracle_Home

Note: The Oracle Home (WebLogic) and the Domain Root directories must 
include only alphanumeric characters, hyphens ('-'), underscore characters ('_
') or slash characters ('/'), and contain at least one letter or digit.

On Windows, backslash characters ('\'), which will be used while using the 
Browse button, are later internally replaced to slash characters ('/') while 
installing the WebLogic server.

Note: Make sure the Node Manager is running. 
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2. Select New Installation and click Next.

The Installation Name and Destination screen is opened.
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3. Enter the installation name and the installation destination and click Next.

The Installer Components screen is opened.

4. Select the component(s) to be installed and click Next.

The Wallet Configuration screen is opened.

Field Description

Name Installation name.

This has to be a unique name which identifies the current installation. All components 
installed during this installation session will be installed under this ID.

Note: The installation name can consist of ASCII characters and numbers, and no special 
characters.

Destination Installation destination.

Root path where Agile e6 is going to be installed. This has to be a non existing path.

Component Description

Server (Daemons, 
Application)

Core EDM Server components.

Java Daemon, FMS Java Daemon, Portmapper, initial Application.

Note: The Oracle database client 32-bit has to be already installed.

Server (J2EE 
Components)

J2EE Agile e6 components

All components which will be deployed to Oracle WebLogic Server.

Note: The Oracle WebLogic Server has to be already installed.

Agile Fileserver The Agile Application Files Server.
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5. Click Next.

The Reference Configuration screen is opened.

Note: If you already created Wallet ZIP archives, you can set Create new 
Wallets to false and navigate to the Wallets Private and Public Archives.

Note: By default, the Create new Wallets field is set to true. That means 
that the paths to the Wallet’s Private Archive and Wallet’s Public Archive 
will be created and cannot be selected. 

Path on Windows: 
%ALLUSERSPROFILE%\agile\installer\6.2.1\wallets\installation\<Installati
on_Name>

Path on UNIX: 
${HOME}/.agile/installer/6.2.1/wallets/installation/<Installation_Name>

File name private Wallet: agile-edm-private-wallets.zip

File name public Wallet: agile-edm-public-wallets.zip

Note: Depending on the selected installer components, the following screen 
can look different.
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6. Configure used Database Instance section.

Setting Description

Client Home The Oracle database client 32-bit home directory.

SQLNet Connect The connect string as it is defined in your %ORACLE_
HOME%/network/admin/tnsnames.ora file.

The entries in tnsnames.ora look like:

MYCONNECTIONSTRING= (DESCRIPTION = (ADDRESS_LIST = 
(ADDRESS = (PROTOCOL = TCP)(HOST = 
MYDATA.MYCOMPANY.COM)(PORT = 1521)) ) (CONNECT_DATA = 
(SID = GOSL) (SERVER = DEDICATED) ) )

In this example The SQLNet connect string would be the first line: 
MYCONNECTIONSTRING.

The tnsnames.ora file can be created and configured with Oracle Net Manager.

For further information about the SQLNet configuration, please refer to 
chapter Post-Installation Modification for the Oracle Database, section 
Configuring the Database Net Service Name.

Host Name The host name of your database server.

SID The SID of the database you want to connect to.

Listener Port The port where the listener listens on the database server.

Database User The database user you want to use for the application.

Database Password The password of the database user.

Verify Password The password entered above has to be repeated for verification.

Import DB Dump Select, if you want the standard dump to be imported to the above defined 
database user.

Create DB User Select, if you want the database user to be created automatically.

SYSTEM Password Password of the Oracle database user.

You only have to apply a value here if you want to create a new database user 
and selected that in the field above.

Verify Password The password entered above has to be repeated for verification.
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7. Configure used WebLogic Server

8. When the reference configuration options are defined, click Next.

The Component Configuration screen is opened.

Setting Description

Oracle Home 
(WebLogic)

The Oracle Home directory where WebLogic is installed, e.g.:

 Windows:

D:/Oracle/Middleware/Oracle_Home

 UNIX

/opt/oracle/Middleware/Oracle_Home

Domain Root The root directory where the Agile e6 WebLogic domains should be created, e.g.:

 Windows

D:/Oracle/Middleware/Oracle_Home/user_projects/domains

 UNIX

/opt/oracle/Middleware/Oracle_Home/user_projects/domains

In this directory, the installer will create all domains used by the Agile e6 J2EE 
components.

Note: The Oracle Home (WebLogic) and the Domain Root directories must 
include only alphanumeric characters, hyphens ('-'), underscore characters ('_
'), or slash characters ('/'), and contain at least one letter or digit.

The Oracle Home (WebLogic) and the Domain Root directories must include 
only alphanumeric characters, hyphens ('-'), underscore characters ('_'), or 
slash characters ('/'), and contain at least one letter or digit

Note: Depending on the selected installer components the following screen 
can look different.
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J2EE Installation Domain Section

Workflow Mail Settings Section

Application Section

Setting Description

Domain Name Name of the domain for the installation specific Agile e6 J2EE components:

WebLogic Server 
Admin Port

The listen port for the WebLogic administration server

WebLogic Server 
Admin SSL Port

The SSL listen port for the WebLogic administration server for the installation 
domain.

Admin Password 
Installation Domain

The password of the WebLogic user used for the installation domain

Verify Password The password entered above has to be repeated for verification.

WebLogic Server 
eSeries Port

The listen port for the WebLogic EDM server. The installer will create a 
separate managed server with name "eSeries-01" in addition to the 
administration server. This server will contain the installation specific 
deployments.

WebLogic Server 
eSeries SSL Port

The SSL listen port for the WebLogic EDM server.

Java Daemon Host 
Name

The host name where the Agile e6 Java Daemon is/will be running

Java Daemon Port The Java Daemon port.

FmsJavaDaemon Host 
Name

The host name where the Agile e6 FMS Java Daemon is/will be running.

FmsJavaDaemon Port The FMS Java Daemon port

Setting Description

Workflow Admin UIC The UIC of an Agile e6 user who has administrative rights for the Workflow 
module. He will receive mails about administrative problems in the Workflow 
module (1000 - 99999).

 This user needs a valid e-mail address as a test e-mail is send when starting 
the MESSENGER.

The messenger does not work at all if this email is missing or wrong!

Mail Server The name of your SMTP mail server if you want to send emails via the 
Business Services. Mailing will be disabled if no host name is set.

Mail Port Number The port number of your SMTP mail server if you want to send emails via the 
Business Services. (587 is the Submission port for using encryption. 25 is the 
old standard SMTP port).

Mail Security If enabled then SSL will be used to encrypt the connection to your SMTP mail 
server if you want to send emails via the Business Services.

SMTP User Name User name if the Mail Authentication for your SMTP mail server is activated.

SMTP User Password Password if the Mail Authentication for your SMTP mail server is activated.

Verify Password The password entered above has to be repeated for verification.
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J2EE Application Domain Section

9. When the component configuration options are defined, click Next.

The Daemon Component Configuration screen is opened.

Setting Description

Name The name of the default application you want to create.

Http Host The host where the Web Client can be reached over HTTP (the WebLogic 
Server hostname).

Http Port The port where the Web Client can be reached over HTTP (the HTTP port of 
WebLogic Server).

J2EE Host The host where Business and/or Web Services are running (the WebLogic 
server host name).

Business Service ECI 
Port

The port where the Business Service will be configured to "listen" for requests 
sent from an EDM Server process.

Web Services ECI Port The port where the Web Services will be configured to "listen" for requests 
sent from an EDM Server process.

Plm 'manager' 
password

Only available if "Import DB Dump" was selected in the step before. Apply 
the password which the plm 'manager' user of the created application should 
have.

Verify Password Only available if "Import DB Dump" was selected in the step before. The 
password entered above has to be repeated for verification

Setting Description

WebLogic Server 
Admin Port

The listen port for the WebLogic administration server for the application 
domain.

WebLogic Server 
Admin SSL Port

The SSL listen port for the WebLogic administration server for the application 
domain.

Admin PWD 
Installation

The password of the WebLogic user used for the application domain.

Verify Password The password entered above has to be repeated for verification.

WebLogic Server 
eSeries Port

The listen port for the WebLogic EDM Server. The installer will create a 
separate managed server with name "eSeries-01" in addition to the 
administration server. This server will contain the application specific 
deployments.

WebLogic Server 
eSeries SSL Port

The SSL listen port for the WebLogic EDM Server.

PLM Authenticator 
Password

Password of the WebLogic user PlmAuthenticatorDSUser, which secures the 
Data Source PlmAuthenticatorDS used by the PLM Authentication provider.

Verify Password The password entered above has to be repeated for verification.
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File Server Section

The File Server default RPC port is 804257548.

To use a different RPC port you have to change the value in the Windows registry after the 
installation has finished and restart the File Server service:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Agile\AgilePLM_
Fileservice\RPC_NMB

Java Daemon Section

Setting Description

Service Name The Windows Service name.

Note for UNIX:

This is not available on a UNIX operating system

Destination The destination of the File Server binaries.

Note: For further information regarding the configuration of the File Server 
and how to set up vaults, please refer to the Online Help > File Server > 
Manager Information documentation.

Setting Description

Service Name The Windows Service name.

Note for UNIX:

This is not available on a UNIX operating system

Port Number The port number the daemon should use.
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FMS Java Daemon Section

RPC Portmapper Section

Windows Service Users Section

Admin Port Number The admin port number the daemon should use.

Registration Port 
Number

The registration portnumber the daemon should use.

Administration 
Password

Password for the administration Interface of the Java Daemon.

Verify Password The password entered above has to be repeated for verification.

Setting Description

Service Name The Windows Service name.

Note for UNIX:

This is not available on a UNIX operating system

Port Number The port number the daemon should use.

Note: This section is only available on a Windows operating system

Setting Description

Service Name The Windows Service name.

Note: This section is only available on a Windows operating system.

Setting Description

Create Unprivileged 
User

Select 'true' if you want the Local Unprivileged Windows User to be created 
automatically.

Unprivileged User 
Name

Local Windows User which is used by the following services: EDM Server, 
Java, FMS Java, and Portmapper.

Unprivileged User 
PWD

Password for the above user.

Note: The password has to comply with the Windows Password policy.

Verify Password The password entered above has to be repeated for verification.

Create Privileged User Select 'true' if you want the Local Privileged Windows User to be created 
automatically.

Privileged User Name Local Windows User which is used by the following service: File Server.

Privileged Group Name Local Windows Group which is used by the privileged user.

Privileged User PWD Password for the above user.

Note: The password has to comply with the Windows Password policy.

Verify Password The password entered above has to be repeated for verification.

Setting Description
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10. When the daemon component configuration options are defined click Next.

The installation begins.

11. After the installation, the services status depends on the operating system.

? Windows

All EDM Server services are not started.

? UNIX

After the installation, all required processes should be running except the AdminClient 
service.

Agile e6 AutoVue Integration Setup
If you want to use the Agile e6 AutoVue Integration, refer to the AutoVue Integration 
Installation and Administration Guide for Agile e6.2.1.0.

Note: Further information about the AdminClient can be found in the 
Administration Guide for Agile e6.2.1.0.



4

Component Based Installation 4-1

4Component Based Installation

This chapter describes the adaptations for a component based installation. Only the differences 
are described.

The EDM Server J2EE components installation requires the WebLogic server on the machine 
where the installation is performed. If you have decided to have WebLogic running on a 
separate server you can follow the steps described below to install J2EE components and native 
components on separate server. This is called component based installation

The installation where J2EE components are installed will be called the "J2EE installation", 
and the installation where native components like Java daemon are installed will be called 
"native installation".

In general, follow the instructions in the section Agile e6 Server of the chapter Installation with 
the Agile e6 Installer.

Requirements
The WebLogic software, as well as the Agile e6 native components need to be installed before 
installing the Agile e6 J2EE components.

Available Components
Following components will be installed:

?  Administration Client

?  Java Daemon

?  FMS Java Daemon

?  Server libraries

?  File Server

?  Applications (plmref)

Note: On Unix, a component based installation also needs to be performed 
when installing the WebLogic server and the EDM Server on the same 
machine with two different OS users. Thus, two Administration Clients with 
the same port numbers are created.

To change the listening port numbers of the Administration Client, please 
refer to the section The Administration Client > Changing the Apache 
Tomcat Configuration in this guide
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File Server Installation
Before starting the installation, be aware of the different Vault types.

Vault Types
? PUB (public)

Public vault with direct read access for all users via mounts or client programs. The file is 
saved with its original file name in the sub-directory 'pub'. 

Write access is only given to ROOT and the File Server user. Every user has read access. 

? FMS

Standard vault, encrypted machine-dependent vault (with predefined names).

Read and write access is only given to the ROOT and the File Server user.

? EIF

Extended storage area, encrypted machine-dependent vault (with cache directories); 
metafiles are created for each file.

Note: File names in public vaults are by default in UTF-8 encoding.

If you already have public vaults on UNIX with ASCII encoding set the 
section[Vaults\Encodings] in the fileserver.cfg file as follows: 

...
[Vaults]
FMS=fms/
EIF=area/
PUB=pub/
[Vaults\Encodings]

PUB=UTF-8

If the entry is missing, UTF-8 will be used. If you replicate public vaults, all 
vaults must have the same encoding setting. 

Note: If you using public vaults with I18N file names you need to consider 
the limitation of the used file system. Some file systems support up to 255 
characters and others only 255 bytes.

In the case of I18N characters one character can need up to 4 bytes.

If you have a mixed environment (Windows and UNIX file server) and you 
replicate public vaults be aware that files which can be checked-in into a 
Windows file server may not be able to be replicated to a UNIX file server, 
because of the file system limitations.

Note: 'EIF' or 'PUB' must be on the same machine where the File Server 
will be executed.
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After the installation on Windows the File Server is started automatically. On UNIX you need 
to start the File Server manually with the provided start script on UNIX. 

This script can be used to start/stop the file server.

./fmssrv start

Installing Agile e6 Native Components
1. Login to the machine where you want to install "Agile e6 Native Components”.

2. Follow the instructions in the section Agile e6 Server of the chapter Installation with the 
Agile e6 Installer.

The Installer Component screen is opened.

Note: We strongly advise you not to use any mounted hard discs as vaults. 
If you do so, you loose performance and reliability, and producing a lot of 
unnecessary net traffic.

All needed and mentioned sub-directories will be created when starting the 
File Server for the first time.

All vaults can be handled by a single executable, the File Server itself. 
Therefore, we recommend to use only one File Server executable on one 
computer, because a thread will be created with each request.

If you enable the logging mechanism of the File Server, be aware that there 
might be confidential information contained. You should restrict the 
read/write access.

Windows systems only support NTFS drives!

Note: WebLogic server installation is not required.

Note: Oracle 32-bit database client installation is required.
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3. Deselect Server (J2EE Components).

This will prevent the setup of the Agile e6 J2EE Components.

If you do not want the Agile File Server to be installed, deselect it too.

4. Click Next.

The Wallet Configuration screen is opened.



Installing Agile e6 Native Components

Component Based Installation 4-5

5. Click Next.

The Reference Configuration screen is opened.

Note: By default, the Create new Wallets field is set to true. That means 
that the Wallet’s Private Archive and Wallet’s Public Archive will be created 
and cannot be selected. 

Path on Windows: 
%ALLUSERSPROFILE%\agile\installer\6.2.1\wallets\installation\<Installati
on_Name>

Path on UNIX: 
${HOME}/.agile/installer/6.2.1/wallets/installation/<Installation_Name>

Note: If only installing the "Agile Fileserver" on a Windows server, you 
can either create a new set of wallets or use the existing wallets from another 
server. A wallet is only used once to create the runtime user or to configure 
the Windows service to use an existing runtime user. The wallets are not 
needed to install only the "Agile Fileserver" on an UNIX OS.

Note: The "Server (J2EE Component)" only installation requires to use the 
same wallets from the "Server (Daemons, Application)" installation.
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The following values must be identical for the native and the J2EE installation.

6. When the reference configuration options are defined, click Next.

7. Adapt the values in the Component Configuration mask.

The following values must be identical for the native and the J2EE installation.

The J2EE Components are not installed at this point. You have to use the values marked in 
red later to setup the Agile e6 J2EE components.

Following values must match the values of your J2EE installation. These are references to 
these values.

The Daemon Component Configuration screen is opened.

Setting Description

Database User The database user you want to use for the application.

Database Password The password of the database user.

Setting Description

Name The name of the default application you want to create.

Setting Description

Http Host The host where the Web Client can be reached over HTTP (the WebLogic 
server hostname).

Http Port The port where the Web Client can be reached over HTTP (the HTTP port of 
WebLogic server).

J2EE Host The host where WebLogic is running (the WebLogic server host name).

Business Service ECI 
Port

The port where the Business Service will be configured to "wait" for requests.

Web Services ECI Port The port where the Web Services will be configured to "wait" for requests.
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To continue, please follow the instructions in section Agile e6 Server step Daemon 
Component Configuration.

Installing Agile e6 J2EE Components

Following components will be installed:

? Administration Client

? Staging directory (see section "Deploying Customer Adapted Files" in the Administration 
Guide for Agile e6.2.1.0)

? Applications (plmref)

? WebLogic Domains containing deployments

To install Agile e6 J2EE components:

1. Login to the machine where you want to install Agile e6 J2EE components.

2. Follow the instructions in the section Agile e6 Server of the chapter Installation with the 
Agile e6 Installer.

The "Installer Component" screen is opened. By default, all options are selected.

3. Deselect Server (Daemons, Application) and Agile Fileserver.

Note: WebLogic domains will not be set up.

Note: Batch deployment tasks must be executed on the J2EE installation 
only

Note: Refer to "Oracle WebLogic Server" section under Chapter 3 
"Installation with the Agile e6 Installer" to install Agile e6.2.1.0 with Oracle 
WebLogic Server.

Note: For the installation you need to copy the private Wallet from the 
Agile EDM Server to the J2EE server. 

Please make sure that nobody but the installation user has access rights to the 
ZIP archive.

Note: You have to use the WebLogic installation user to install the Agile 
e6 J2EE components.

Note: Oracle database client installation is not needed.
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This will prevent the setup of the "Agile e6 Native Components".

4. Click Next

The Wallet Configuration screen is opened.

5. On the J2EE server, select the path to the archive of the private Wallet, which was 
generated on the Agile EDM Server.

6. Click Next.

The Reference Configuration screen is opened.
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The following values must be identical for the native and the J2EE installation.

7. When the reference configuration options are defined, click Next.

The Component Configuration screen is opened.

The following value must be identical for the native, and the J2EE installation.

Setting Description 

Database User The database user you want to use for the application.

Database Password The password of the database user.

Setting Description

Name The name of the default application you want to create
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8. Apply the values of your native installation as given in fields.

Following values must match the values of your native installation. These are references to 
these values.

9. Follow the instructions in the installation documentation of your operating system.

Creating the Application
In a component based installation, every application has to be created on the native installation, 
and on the J2EE installation. The Administration client, however, is available for both 
installations. The Administration client checks whether it should manage a J2EE or a native 
installation.

Applications can be created as usual. Following two screenshots show the differences to the 
default web forms for the application creation with the Administration Client.

Setting Description

Java Daemon Host Name The hostname where the Agile e6 Java Daemon is/will be running.

Java Daemon Port The Java Daemon port.

FmsJava Daemon Host Name The hostname where the Agile e6 FMS Java Daemon is/will be 
running.

FmsJava Daemon Port The FMS Java Daemon port.
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J2EE Application Creation

NATIVE Application Creation
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5Agile e6 Batch Installation

This chapter describes the batch installation of the Agile e6 Server components. As the Agile 
e6.2.1.0 installer is fully batch enabled, all installation tasks can be done in batch mode with the 
batch scripts batchinstall.csh and batchinstall.cmd which can be found in the directory 
(<installation-media-path\installer)

Introduction
As described in the previous chapters, you can either do a complete Agile e6 installation with 
native EDM Server, File Server and WebLogic domains or a component-based installation 
installing certain components individually.

In Batch mode you can do a Master Installation for all components or for certain components 
which is defined by the respective parameters. In addition you can copy an existing Master 
Installation (Clone Installation) or execute a J2EE Installation or DFM site installation.

The following parameters are available 

Before you can run a Batch Installation, you need to adapt your specific installation attributes 
in the properties file. 

We recommend using the templates provided in the folder 
<install-media-path>/installer/properties to make sure that all attributes are included / defined 
in the respective properties file. If attributes are missing, the batch installation might not be 
successful and needs to re-run. 

Note: The Clone and J2EE Installation require a Master Installation first to 
create the respective wallets/encrypted password needed when running the 
batch installation.

Parameter Components

ALL The native EDM Server, File Server and WebLogic domains with all deployments.

E6S The native EDM Server.

E6F The native EDM Server and the File Server.

E6J The native EDM Server and WebLogic domains with all deployments.

DFM The File Server, FMS Java Daemon, and the Tomcat server with the DFM 
deployments.

FMS The File Server.

J2EE The WebLogic domains with all deployments.
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The following list shows all Batch Installation parameters and the related properties template. 

Depending on the selected parameter, you need to define the respective properties in the 
properties file: 

Parameter Example properties file

ALL tpl_installation.properties

E6S tpl_installation.properties

E6F tpl_installation.properties

E6J tpl_installation.properties

DFM examples/batch_install_dfm.properties

FMS examples/batch_install_fms.properties

J2EE tpl_installation.properties

Note: When initially adapting the properties file, leave any <password> 
attributes empty as they will be updated later with encrypted passwords 
created by the EPKEYTOOL in connection with creating wallets. More 
information on wallets and encrypted passwords can be found in the Agile 
EDM Security Guide.

Property Description

plm.databasedefinition.dbhost Host name of the Oracle Database server.

 plm.j2eeappserver.jadehost Host name where the Java Daemon is/will be running.

plm.j2eeappserver.fmsjadehost Host name where the FMS Java Daemon is/will be running.

 plm.j2eeappserver.adminserver_
password

Password of the WebLogic administration user (weblogic) for the 
installation domain.

plm.application.j2eehost Host name where WebLogic is running (the WebLogic Server host 
name).

 plm.application.httphost Host name where the Agile e6 Web Client can be reached over 
HTTP (the WebLogic server hostname).

plm.application.dbpassword Password of the database user for the application.

plm.application.mailrelay: To send emails with the business services, define the name of your 
SMTP mail server. Otherwise use "nn".

plm.application.mail_auth_user User name if the Mail Authentication for your SMTP mail server 
is activated. Leave it empty if the plm.application.mail_use_
authentication property is set to false.

plm.application.mail_auth_
password

Password if the Mail Authentication for your SMTP mail server is 
activated. If the plm.application.mail_use_authentication property 
is set to false, leave it empty.

plm.application.plm_auth_
provider_password

Password of the WebLogic user PlmAuthenticatorDSUser, which 
secures the Data Source PlmAuthenticatorDS that is used by the 
PLM Authentication provider.

plm.application.adminserver_
password

Password of the WebLogic administration user (weblogic) for the 
application domain.
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After having defined your properties file, you can call your batch script with the following 
components.

Windows: batchinstall.cmd <properties files><components> 
Unix: batchinstall.csh <properties files><components>

Master Installation
With the Master Installation, the native EDM Server, File Server and WebLogic domains with 
all deployments are installed in batch mode.

Requirements
? All prerequisites mentioned in the Prerequisite Guide for Agile are met before performing 

the batch installation.

plm.inst.wallets.private.archive Master or DFM Batch Installations - Full path (incl. filename) for 
the to be created private wallets archive.

Clone or J2EE Batch Installations - Full path (incl. filename) to the 
existing private wallets archive from the Master installation.

plm.inst.wallets.public.archive Master Installation- Full path (incl. filename) for the to be created 
public wallets archive.

Clone, J2EE or DFM Batch Installations - Full path (incl. 
filename) to the existing public wallets archive from the Master 
installation.

plm.javadaemon.admpwd Password for the administration interface of the Java Daemon.

Plm.userdefinition.priv_password Password of the local Windows user which is used by the 
following service: File Server.

 Plm.userdefinition.unpriv_
password

Password of the local Windows user which is used by the 
following services: EDM Server, Java, FMS Java, and Portmapper.

plm.application.managerpassword Apply the password which the plm 'manager' user of the created 
application should have.

This password property must only be defined if you define 
property "plm.application.dumpimport=true".

plm.applicationserverdefinition.ora_
inventory_unix_group

Not used on Windows. Please see the UNIX section below. Please 
remove the <CHANGETHIS> from the entry on Windows.

Note: The parameter INIT has to be executed once before using the 
parameters WALLET or DFMWALLET. You can then use the other 
parameters listed below. 

The WALLET option must also be executed while doing a J2EE component 
based installation. This will set up the wallets which are required when using 
the Administration Client.

Parameter Components

INIT Initial task which has to be executed once for an installation.

WALLET Create the required server wallets.

DFMWALLET Create the required wallets for a DFM site.

Property Description
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? Deploying the J2EE application in batch modes requires a WebLogic Node Manager which 
has been configured and is running. WebLogic domains will be setup and started during the 
batch installation (Component-based Installation).

? Database Client and Server, and WebLogic Server installation have to be available. The 
Database must be running before starting to install Agile e6 J2EE and EDM Server 
Complete Installation).

Create and update the batch properties file

Windows

1. Copy the example property file from <installation-media-path>/installer/properties/tpl_
installation.properties to 
<installation-media-path>/installer/properties/installation.properties

This file contains the default values for a Windows batch installation

2. Enter the values for all properties with value <CHANGETHIS> but leave any parameters 
<password...> empty as these will be added later. .

3. Check if the remaining values match your environment and/or change the values if you do 
not want to use the default values.

UNIX

On a UNIX operating system, you need to change the following properties, which also contain 
a directory path:

Note: Use double backslashes for plm.inst.root, 
plm.applicationserverdefinition.mw_home, and 
plm.applicationserverdefinition.domain_root on Windows:

e.g. plm.inst.root=C:\\plm621

Use quadruple backslashes for plm.fileserver.destination on Windows

e.g. plm.fileserver.destination:C\\\\fms

Note:  '$' character in property values should be replaced with '$$'.

e.g. the property value 'pa$$word$' has to be changed to 'pa$$$$word$$'

Property Description

 plm.inst.root The destination directory for the Agile e6 installation.

 plm.databaseconnection.client_home The path to the existing 32-bit Oracle Database client.

 plm.fileserver.destination: The destination path for the File Server installation.

 plm.applicationserverdefinition.ora_
inventory_unix_home

Inventory root directory for the Oracle Universal Installer for 
WebLogic.

plm.applicationserverdefinition.ora_
inventory_unix_group:

Name of the group which has write permissions to 
create/update the Oracle Home Inventory directory for the 
WebLogic server



Master Installation

Agile e6 Batch Installation 5-5

Initialize the Batch Installation

Windows

1. Open an Administrative command shell and change to the installer directory:

cd <installation-media-path>\installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

set JAVA_HOME=C:\Program Files\Java\jdk1.8.0_<update_number>
3. Execute the following command in your previously opened command shell:

batchinstall.cmd properties/installation.properties INIT

UNIX

1. Open a csh shell and change to the installer directory:

cd <install-media-path>/installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>
3. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties INIT |& tee 
installation.log

The log files can be found in the directory

Windows: %ALLUSERSPROFILE%\agile\installer\6.2.1\log

Unix: ${HOME}/.agile/installer/6.2.1/log

Create the Master Oracle Wallet Packages

1. Edit the installation.properties file and change the following properties

? plm.inst.wallets.private.archive=<Full path (incl. filename) for the newly created 
private wallets archive>

? plm.inst.wallets.public.archive=<Full path (incl. filename) for the to be created public 
wallets archive>

 plm.applicationserverdefinition.mw_
home

The Oracle Home directory under which the Middleware 
software is installed.

plm.applicationserverdefinition.domain
_root:

The root directory where the Agile e6 WebLogic domains 
should be created.

plm.wls.installer Full path to the WebLogic installer jar file.

 plm.wls.java.executable.name The Windows name is the default.

The value for UNIX is commented out below it. Reverse the 
comments for the two lines.

Note: For more information about wallets refer to the Agile EDM Security 
Guide

Property Description
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Example: 

plm.inst.wallets.private.archive=C:\\temp\\installer\\wallets\\agile-edm-privat
e-wallets.zip
plm.inst.wallets.public.archive=C:\\temp\\installer\\wallets\\agile-edm-public-
wallets.zip

2. Execute the following command in your command shell:

Windows:

batchinstall.cmd properties\installation.properties WALLET

UNIX:

./batchinstall.csh properties/installation.properties WALLET

This command creates the master Oracle wallet packages which you must use for the other 
installation modes (Clone, J2EE, DFM).

? The agile-edm-private-wallets.zip contains the master Oracle wallets (Including the private 
keys). This ZIP file must be protected against unauthorized access! Use secure transfer 
methods when you install other servers.

? The agile-edm-public-wallets.zip contains the public key of the master server Oracle 
wallet.

Encrypt Passwords
Some of the properties which you have to change in the installation.properties file are 
passwords.

You have to enter them encrypted to secure your installation. The Agile e6 installer package 
provides the epkeytool to encrypt sensitive data.

To encrypt your passwords call the following command script:

Windows:

tools\bin\epkeytool.bat -encryptpwd -keyStore 
file://%ALLUSERSPROFILE%\agile\installer\6.2.1\wallets\installation\AgileInstallat
ion62\wallet\private\server\cwallet.sso -keyAlias orakey

The epkeytool prompts for the password to encrypt and copies them to the clipboard.

UNIX:

tools/bin/epkeytool.sh -encryptpwd -keyStore 
file://${HOME}/.agile/installer/6.2.1/wallets/installation/AgileInstallation62/wal
let/private/server/cwallet.sso -keyAlias orakey

The epkeytool prompts for the password to encrypt and prints the encrypted password in the 
command shell.

Note: Please make sure that the created installation.properties file is either 
highly secured, or will be deleted once the installation is done, because it 
contains passwords.
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Update the installation.properties file with the encrypted passwords
1. Open the property file from 

<install-media-path>/installer/properties/installation.properties.

2. Copy the encrypted password to the correct place in the installation.properties file.

? plm.application.adminserver_password

? plm.application.dbpassword

? plm.application.mail_auth_password

? plm.application.plm_auth_provider_password

? plm.j2eeappserver.adminserver_password

? plm.userdefinition.priv_password

? plm.userdefinition.unpriv_password

? plm.application.managerpassword

? plm.javadaemon.admpwd

Execute the Batch Installation

1. Execute the following command in your command shell:

Windows:

batchinstall.cmd properties\installation.properties ALL

UNIX:

./batchinstall.csh properties/installation.properties ALL

The complete server installation is executed and will take about 20 min.

A log file, installation.log tis created in the directory 
%ALLUSERSPROFILE%\agile\installer\6.2.1\log. It will be overwritten every time you will 
call batchinstall.cmd again.

After the installation the following Agile6 environments are created:

Windows Services Following Windows Services are available but not started:

?  AgilePLM_Fileservice

?  AgilePLM_JavaDaemon

?  AgilePLM_FMS_JavaDaemon

?  AgilePLM_Portmapper

WegLogic Domains During the installation, 2 domains were created. Each domain consists of an 
AdminServer and an Agile eSeries-01 server.

?  The AdminServer is only for the administration of the domain.

?  The Agile eSeries-01 servers contain the Agile e6 deployments.

The domains directory, as defined in plm.applicationserverdefinition.domain_
root, contains the domains eSeries_domain, and eSeries_domain_plmref.
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Clone Installation
If you want to create another server installation based on the master installation, use the Clone 
Installation option. 

Requirements
? All prerequisites mentioned in the Prerequisite Guide for Agile are met before performing 

the batch installation.

? Deploying the J2EE application in batch modes requires a WebLogic Node Manager which 
has been configured and is running. WebLogic domains will be setup and started during the 
batch installation.

? Database Client and Server, and WebLogic Server installation have to be available. The 
Database must be running before starting to install Agile e6 J2EE and EDM Server.

? To create another server installation based on the master installation you need to copy three 
files from your master installation:

? installation.properties

? agile-edm-private-wallets.zip

Ports E6 AdminClient -> 8080

Java Daemon -> 16087

Fileservice -> 804257548

"plmref" BusinessService ECI Port -> 19997

"plmref" WebServices ECI Port -> 19998

WebLogic eSeries_domain -> AdminServer -> 7101

WebLogic eSeries_domain -> AdminServer, SSL -> 7102

WebLogic eSeries_domain ->eSeries-01 -> 7103

WebLogic eSeries_domain ->eSeries-01, SSL -> 7104

WebLogic eSeries_domain_plmref -> AdminServer -> 7105

WebLogic eSeries_domain_plmref -> AdminServer, SSL -> 7106

WebLogic eSeries_domain_plmref -> eSeries-01 -> 7107

WebLogic eSeries_domain_plmref -> eSeries-01, SSL -> 7108

WebLogic Node Manager -> 5559

Oracle Database Listener -> 1521

Links Java Client WebStart: 
https://<servername>:7104/Jacc/jacc.jnlp

Web Client: 
https://<servername>:7104/AgilePlmWps

DaemonAdminServlet: https://<servername>:7104/DaemonAdminServlet

HTTPSupport: 
https://<servername>:7104/plm-api-axis/services

AdminClient: 
http://<servername>:8080/AdminClient

WebLogic Admin Console:

eSeries_domain: https://<servername>:7102/console

eSeries_domain_plmref:https://<servername>:7106/console
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? agile-edm-public-wallets.zip

Create and Update batch property file
1. Copy the tpl_installation.porperties file from 

<installation-media-path>/installer/properties/tpl_installation.properties to 
<installation-media-path>/installer/properties/installation.properties.

2. Edit the installation.properties file and change the following properties

?  plm.inst.wallets.private.archive=<Full path (incl. filename) to the existing private 
wallet archive>

? plm.inst.wallets.public.archive=<Full path (incl. filename) to the existing public 
wallets archive>

Example:

plm.inst.wallets.private.archive=C:\\temp\\installer\\wallets\\agile-edm-privat
e-wallets.zip
plm.inst.wallets.public.archive=C:\\temp\\installer\\wallets\\agile-edm-public-
wallets.zip

3. Check the host names and ports in the installation.properties file and change them to meet 
your infrastructure.

For example the following host settings should point to the server where you execute the 
installation:

? plm.j2eeappserver.jadehost

? plm.j2eeappserver.fmsjadehost

? plm.application.j2eehost

? plm.application.httphost

There might be some additional host settings that need to be adapted.

4. Deactivate the DUMP import copying the installation.properties file to the 
<install-media-path>/installer/properties folder and change the following line:

plm.application.dumpimport=false

Initialize and Execute Batch Script

Windows

1. Open an Administrative command shell and change to the installer directory:

cd <installation-media-path>\installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

set JAVA_HOME=C:\Program Files\Java\jdk1.8.0_<update_number>
3. Execute the following command in your previously opened command shell:

batchinstall.cmd properties\installation.properties INIT
4. Execute the following command in your previously opened command shell:

batchinstall.cmd properties\installation.properties WALLET
5. Execute the following command in your previously opened command shell:

batchinstall.cmd properties\installation.properties ALL
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UNIX

1. Open a csh shell and change to the installer directory:

cd <install-media-path>/installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>
3. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties INIT |& tee 
installation.log

4. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties WALLET |& tee 
installation.log

5. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties ALL |& tee 
installation.log

The clone installation is executed. 

A log file, installation.log tis created in the directory 
%ALLUSERSPROFILE%\agile\installer\6.2.1\log. It will be overwritten every time you will 
call batchinstall.cmd again.

After the installation the same Agile6 environments are created as described in the Master 
Installation above. 

J2EE Installation 
This component-based installation will install the WebLogic domains with all deployments on 
your a separate server. 

Requirements
? All prerequisites mentioned in the Prerequisite Guide for Agile are met before performing 

the batch installation.

? Deploying the J2EE application in batch modes requires a WebLogic Node Manager which 
has been configured and is running. WebLogic domains will be setup and started during the 
batch installation.

? Database Client and Server, and WebLogic Server installation have to be available. The 
Database must be running before starting to install Agile e6 J2EE and EDM Server.

? To create a J2EE installation based on the master installation you need to copy the 
following three files from your master installation

? installation.properties

? agile-edm-private-wallets.zip

? agile-edm-public-wallets.zip

Create and Update batch property file
1. Copy the installation.properties file (template: tpl_installation.properties) to the folder 

<install-media-path>/installer/properties 

2. Edit the installation.properties file and change the following properties
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? plm.inst.wallets.private.archive=<Full path (incl. filename) to the existing private 
wallet archive>

? plm.inst.wallets.public.archive=<Full path (incl. filename) to the existing public 
wallets archive>

Example:

plm.inst.wallets.private.archive=C:\\temp\\installer\\wallets\\agile-edm-privat
e-wallets.zip
plm.inst.wallets.public.archive=C:\\temp\\installer\\wallets\\agile-edm-public-
wallets.zip

3. Check the host names and ports in the installation.properties file and change them to meet 
your infrastructure.

For example the following host settings should point to the server where you execute the 
installation:

? plm.j2eeappserver.jadehost

? plm.j2eeappserver.fmsjadehost

For example the following host settings should point to an Agile e6 native server which 
should be used from your J2EE installation:

? plm.j2eeappserver.jadehost

? plm.j2eeappserver.fmsjadehost

There might be some additional host settings that need to be adapted.

4. Deactivate the DUMP import copying the installation.properties file to the 
<install-media-path>/installer/properties folder and change the following line:

plm.application.dumpimport=false

Initialize and Execute the Batch Script

Windows

1. Open an Administrative command shell and change to the installer directory:

cd <installation-media-path>\installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

set JAVA_HOME \usr\local\java/jdk1.8.0_<update_number>
3. Execute the following command in your previously opened command shell:

batchinstall.cmd properties\installation.properties INIT
4. Execute the following command in your previously opened command shell:

batchinstall.cmd properties\installation.properties WALLET
5. Execute the following command in your previously opened command shell:

batchinstall.cmd properties\installation.properties J2EE

UNIX

1. Open a csh shell and change to the installer directory:

cd <install-media-path>/installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>
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3. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties INIT |& tee 
installation.log

4. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties WALLET |& tee 
installation.log

5. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/installation.properties J2EE |& tee 
installation.log

The J2EE installation is executed. 

A log file, installation.log tis created in the directory 
%ALLUSERSPROFILE%\agile\installer\6.2.1\log. It will be overwritten every time you will 
call batchinstall.cmd again.

DFM Batch Installation
The batchinstall script with the DFM option will install the following components:

?  Tomcat with the Metro web service stack

–  On Windows it will create a service entry for starting the Tomcat

–  Deployments for:

* Java Client WebStart

* Wrapper for the AutoVue viewer

* Agile e6 AutoVue Integration

* Web Fileservice

* Streaming Fileservice

?  FMS Java Daemon

?  File Server

Requirements
? All prerequisites mentioned in the Prerequisite Guide for Agile are met before performing 

the batch installation.

? The latest Tomcat version 8 with Java 8 64-Bit has to be installed on the DFM site(s) 
server. The Tomcat 8 core binary distribution can be downloaded from 
http://tomcat.apache.org/

The Metro web service stack has to be installed too if File Web Services are used. The 
Metro web service stack zip archive can be downloaded from http://metro.java.net/

Note: Only on Windows the Tomcat 8 64-bit version is supported by the 
batch installation

Note: Tomcat 8 and the Metro web service stack can be installed with the 
batch installation for the FMS services.
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?  A fully extracted Agile e6 package from the Oracle Software Delivery Cloud on the DFM 
site(s) server.

Create and Update Batch Property File 

1. Copy the <installation-media-path>/installer/properties/examples/batch_install_
dfm.properties to the <installation-media-path>/installer/properties directory.

2. Update the installation.properties file 

plm.inst.name=<AgileInstallation62>
plm.inst.root=<c:\\plm62>

Initialize Batch Installation 

Windows

1. Open an Administrative command shell and change to the installer directory:

cd <installation-media-path>\installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

set JAVA_HOME=c:\Program Files\Java\jdk1.8.0_<update_number>
3. Execute the following command in your previously opened command shell:

batchinstall.cmd properties/batch_install_dfm.properties INIT

UNIX

1. Open a csh shell and change to the installer directory:

cd <install-media-path>/installer
2. Set the JAVA_HOME environment variable to the installed Java Development Kit. This 

has to be a 64-bit Java 8 Development Kit.

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>
3. Execute the following command in your previously opened csh shell:

./batchinstall.csh properties/batch_install_dfm.properties INIT |& tee 
installation.log

Create the DFM Oracle Wallet Package
1. Copy the agile-edm-public-wallets.zip from your master installation to the location you 

have defined above

2. Edit the batch_install_dfm.properties file and change the following properties

? plm.inst.wallets.private.archive=<Full path (incl. filename) to the existing private 
wallet archive>

? plm.inst.wallets.public.archive=<Full path (incl. filename) to the existing public 
wallets archive>

Note: When initially adapting the properties file, leave any <password> 
attributes empty as they will be updated later with encrypted passwords 
created by the EPKEYTOOL in connection with creating wallets. More 
information on wallets and encrypted passwords can be found in the Agile 
EDM Security Guide.
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3. Execute the following command in your previously opened shell.

Windows: 

batchinstall.cmd properties\batch_install_dfm.properties DFMWALLET

UNIX: 

./batchinstall.csh properties/batch_install_dfm.properties DFMWALLET |& tee 
installation.log

This command creates the DFM Oracle wallet package which is used to encrypt local 
passwords.

? The agile-edm-private-wallets.zip contains the local DFM Oracle wallets (Including 
the private keys).

Encrypt Passwords
Some of the properties which you have to change in the batch_install_dfm.properties file are 
passwords.

You have to enter them encrypted to secure your installation. The Agile e6 installer package 
provides the epkeytool to encrypt sensitive data.

To encrypt your passwords call the following command script:

Windows:

tools\bin\epkeytool.bat -encryptpwd -keyStore 
file://%ALLUSERSPROFILE%\agile\installer\6.2.1\wallets\installation\AgileInstallat
ion62\wallet\private\server\cwallet.sso -keyAlias orakey
UNIX:

tools/bin/epkeytool.sh -encryptpwd -keyStore 
file://${HOME}/.agile/installer/6.2.1/wallets/installation/AgileInstallation62/wal
let/private/server/cwallet.sso -keyAlias orakey

The epkeytool prompts for the password to encrypt and prints the encrypted password in the 
command shell.

Update the installation.properties file with the encrypted passwords
1. Open the property file from <install-media-path>/installer/properties/batch_install_

dfm.properties

2. Copy the encrypted password to the correct place in the batch_install_dfm.properties file.

? plm.userdefinition.priv_password

? plm.userdefinition.unpriv_password

Execute the Batch Installation
1. Execute the following commands in your previously opened shell:

Windows

batchinstall.cmd properties/batch_install_dfm.properties DFM

UNIX
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./batchinstall.csh properties/batch_install_dfm.properties DFM |& tee 
installation.log
The DFM installation is executed.

A log file, installation.log tis created in the directory 
%ALLUSERSPROFILE%\agile\installer\6.2.1\log. It will be overwritten every time you will 
call batchinstall.cmd again.
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6Oracle Database 12c

Oracle Database Prerequisites 12c

Windows
Create the directories/drives for the distribution of the data files depending on the number of 
disks prepared for the Oracle installation.

For instance, if you have prepared 3 disks -

?  E:\

?  F:\

?  H:\

The drive letters E:\, F:\, and H:\ are just examples. Subdirectories will be created later in these 
directories by either:

?  Manual installation

–  Installing Oracle Database Server

–  Installing Oracle Database Client

?  Automatic installation

–  Installation with the Agile e6 Installer

UNIX

Setting Up an Oracle Operating System User
Several operating system groups and users might have to be installed, depending on:

?  If Oracle software is installed on this system the first time

?  Installed products

For complete information on how to set up an Oracle Operating System User, refer to the 
Oracle Database Software documentation.

Note: This chapter describes prerequisites for installing the Oracle 
Database client and server on all supported operating systems.
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To create an Oracle account:

1. Create the dba group for the machine on which Oracle is being installed:

groupadd -g 502 dba

2. Create an Oracle user "oracle" with the following parameter and execute the following 
command.

?  Home directory "/opt/oracle"

?  Login shell "/bin/csh"

?  Member of the group "dba"

useradd -u 502 -g dba -d /opt/oracle -s /bin/csh oracle

3. Log into Oracle and create the subdirectories:

?  /opt/oracle/bin

?  /opt/oracle/product

?  /opt/oracle/product/12.0.1

4. Create the directory, links, and mount points for distribution of the data files, depending on 
the number of disks prepared for the Oracle installation.

For instance, if you have prepared 3 disks:

?  …/data1

?  …/data2

?  …/data3

The names data1, data2, and data3 are just examples.

Subdirectories will be created later in these directories by the database:

?  Manual installation

– § Installing Oracle Database Server

– § Installing Oracle Database Client

?  Automatic installation

– § Installation with the Agile e6 Installer

Note: On AIX you have to use the following command instead:

mkgroup id=502 dba

Note: This is also value for ORACLE_BASE. The directory must be 
created first.

Note: If ORACLE_BASE is not set to /opt/oracle, the above mentioned 
subdirectories have to be created in the designated directory.
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Setting Up the Shell Environment Variables for Oracle 12c
To set up the shell environment variables, do the following:

1. Download and uncompress the Oracle Agile Engineering Data Management Application 
(Release e6.2.1.0) from the Oracle Software Delivery Cloud website.

Under Oracle Agile Applications > Oracle Agile Engineering Data Management (Release 
e6.2.1.0) Media Pack.

2. Copy the script csh_ORA12.1 from the folder addon/db/unix/scripts to /opt/oracle/bin

If ORACLE_BASE is not set to /opt/oracle, open the script with an editor and change the 
value for ORACLE_BASE. Then source the script to set the environmental variables.

chmod 754 csh_ORA12.1

source $HOME/csh_ORA12.1

3. Set the file creation permissions with the "umask" command:

umask 022

4. Verify the environment.

5. Log off and log in as the Oracle user to ensure all environment settings are active.

6. Type env | sort in the UNIX prompt to view all environment variables.

Note: For recommended disk layout, please check the Hardware Sizing 
Guide for Agile e6.2.1.0

Software Item Requirements

DISPLAY Set it to the machine name and monitor the station from which you are 
connecting to the server machine (setenv DISPLAY hostname: 0.0).

LD_LIBRARY_PATH

SHLIB_PATH 
(HP-UX)

LIBPATH (AIX)

Required for Oracle products using shared libraries. Must include:

 $ORACLE_HOME/lib.

ORACLE_BASE Not required, but recommended as part of an OFA-compliant installation.

ORACLE_HOME Must be set to the directory where the Oracle software will be installed.

ORACLE_SID Specifies the instance name, or SID of the Oracle Server. Must be unique for 
Oracle instances running on the same machine. Oracle Corporation 
recommends using four characters or less.

ORACLE_TERM Required by all character mode and Motif mode Oracle products. 386 386x 
386u 386s dgd2 dgd4 hftc hft hpterm 3151 ncd220 sun sun5 vt100 vt220 wy50 
wy150 xsun xsun5.

ORA_NLS10 Required when creating a database with characters set other than US7ASCII. 
Set to $ORACLE_HOME/nls/data

PATH The search path must include: $ORACLE_HOME/bin, /bin, /usr/bin, and 
/usr/local/bin.

TMPDIR A directory with free space where the Oracle account has write permission. 
The default location on UNIX is /usr/tmp.
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Free Up Disk Space in the /tmp Directory
The Oracle Installer needs some temporary disk space during the installation in /tmp. Check the 
required space in tmp directory under Hardware Requirements for the relevant operating 
system.

To determine the amount of free disk space available in the /tmp directory, enter the following 
command in a command shell:

df /tmp

If the space available in the /tmp directory is less than required, complete one of the following 
steps:

1. Delete unnecessary files from the /tmp directory to achieve the required disk space.

2. Set the TEMP and TMPDIR environment variables when setting the Oracle user's 
environment (described later).

3. Extend the file system that contains the /tmp directory. If necessary, contact your system 
administrator for information about extending file systems.

If you have determined that the /tmp directory had insufficient free disk space when checking 
the hardware requirements, enter the following commands to set the TEMP and TMPDIR 
environment variables. Specify a directory on a file system with sufficient free disk space.

?  In a Bourne, Bash, or Korn shell:

TEMP=/directory
TMPDIR=/directory
export TEMP TMPDIR

?  In a command shell:

setenv TEMP /directory
setenv TMPDIR /directory

Copying the Database Start and Stop Scripts for the Oracle Server
Copy the start and stop scripts from folder addon/db/unix/scripts to the directory 
/opt/oracle/bin.

?  start_plm62

?  stop_ plm62

?  stop_ plm62_immediate

?  stop_ plm62_transactional

Installing Oracle Database Server 12c

Note: For disk space requirements check the specific Quick Installation 
Guide Section provided with the Operating System.

Note: This chapter describes the manual installation of the Oracle Database 
Server. Keep in mind that on UNIX only the manual installation can be 
performed. For the installation on a Windows operating system with the 
Agile e6 Installer see chapter Installation with the Agile e6 Installer.
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Start the Oracle Database installation

?  Windows

Run setup.exe from the downloaded Oracle Installation Media.

?  UNIX

Log in as the oracle user and navigate to the database directory. Start the Oracle Universal 
Installer with the following command:

./runInstaller

The Configure Security Updates screen is opened.

You can opt for notifications about security issues and security updates from My Oracle 
Support.

1. To receive notifications about the security issues via email, enter your email address in the 
Email text field.

2. To receive security updates:

a. Enter the email address you have provided when registering with My Oracle Support.

b. Select the I wish to receive security updates via My Oracle Support option and enter 
your My Oracle Support password.

Note: If you have already installed Oracle database client (32-bit) on the 
same machine, please restart it before installing the Oracle database server.

Note: If you wish not to receive security updates, do not check the I wish to 
receive security updates via My Oracle Support check box.
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By default, the I wish to receive security updates... option is not selected. If your 
company's policy requires such updates, then this option should be selected.

3. Click Next.

The My Oracle Support Username/Email Address Not Specified warning appears.

4. Click Yes.

The Select Installation Option screen is opened.

5. Select Install database software only and click Next.

The Grid Installation Options screen is opened.
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6. Select Single instance database installation and click Next.

The Select Product Languages screen is opened.

Note: The Real Application Cluster database installation is not a subject of 
this guide.
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7. Select English as the product language.

If you want the Oracle database to operate in any other language select the required 
language from the list of the product languages.

8. Click Next.

The Select Database Edition screen is opened.

9. After your selection, click Next.

The Specify Oracle Home screen is opened.

The Oracle Home User is different from an Oracle Installation User. The Oracle 
Installation User is the user who requires administrative privileges to install Oracle 
products. The Oracle Home User is used to run the Windows services for the Oracle Home.

The Oracle home user can be the Windows build-in account or a Windows user account. 
For enhanced security, Oracle recommends that a standard Windows user account be 
chosen as the Oracle home user for a database server installation. If a Windows user 
account is used, it must be a standard Windows user account (not an administrator) and for 
single instance database installations can be a local user, a domain user, or a managed 
services account. For Oracle Database RAC installations, the Windows user account must 
be a domain user.

Note: The scope of translation for a given component may differ from 
language to language. For example, some translations may include all the 
user interface texts, while some may include only the error messages without 
any help file.
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10. Specify the Oracle home user and click Next.

The Specify Installation Location screen is opened.

11. Specify the installation location for the Oracle Base directory and the Software Location 
which is the Oracle Home directory (e.g. $ORACLE_BASE/product/12.1.0/dbhome_1).

If the selected Oracle home location is the same as the user home directory, the following 
warning message appears:

[INS-32008] Oracle base location can't be the same as the user home directory.
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If the selected Oracle home location is outside of Oracle base, the following warning 
message appears:

[INS-32018] The selected Oracle home is outside of Oracle base.

If possible avoid having the Oracle home outside of Oracle base.

12. To override the warning, click Yes.

The Perform Prerequisites Checks screen is opened, displaying the verification process.

Upon completion of the checks, the installer displays the results for review.

If any of the requirements are not met, the installer displays a list of the failed checks and 
their actual and expected values.

Note: If possible, avoid having the same directory for the Oracle Base and 
the Oracle home directory.

Note: UNIX

The Fix & Check Again button, and the function to create a fixup script will 
only appear on a UNIX operating system.

You may click the Fix & Check Again button to generate a fixup script. 

The nodes on which the prerequisites failed, are listed in the Execute Fixup 
Script window. You can run the fixup script as a root user to complete the 
required pre-installation steps.

Using the fixup scripts does not ensure that all the prerequisites for installing 
the Oracle Database are satisfied. You still have to verify that all the 
pre-installation requirements are met to ensure a successful installation.
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When all of the minimum requirements are met, the Summary screen is opened.

13. In the Summary screen, review the global settings you have chosen and click Install to start 
the installation.

The Installation Progress screen is opened.
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14. When the installation completes, the Finish screen is opened

15. Click Close to exit.

Installing Oracle Database Client

Note: For Oracle Database 12cR1 (12.1.0.2), you can install the database 
server patch (64-bit) if required:

- WINDOWS DB BUNDLE PATCH 12.1.0.2.4 - 20684004

- UNIX - PRO*C METHOD 4 LEAKS MEMORY IN 12.1 - 20051833

Note: Further information about these database server patches can be found 
on the Oracle Patches and Updates support website:

- Windows: 
https://updates.oracle.com/Orion/Services/download?type=readme&aru=187
84207

- UNIX example: 
https://updates.oracle.com/Orion/Services/download?type=readme&aru=183
69852

Note: This chapter describes the manual installation of the Oracle Database 
client. Keep in mind that on UNIX only the manual installation can be 
performed. For the automatic installation on a Windows operating system 
refer to the chapter Installation with the Agile e6 Installer.
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1. The first step of the installation is different for Windows and UNIX.

? Windows

1. Run setup.exe from the downloaded Oracle Installation Media.

? UNIX

1. Log in as the Oracle user and start the Oracle Universal Installer with the following 
command:

./runInstaller

The Select Installation Type screen is opened.

2. Select Custom and click Next.

The Download Software Updates screen is opened.

Note: If you have already installed Oracle database server on the same 
machine, please restart it before installing the Oracle database client.

Note: The 32-bit Oracle client must be installed on the same machine 
where Agile e6.2.1.0 is installed.
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3. Select Skip software updates and click Next.

Skip software updates is the default selection.

The Select Product Languages screen is opened.

4. Select English as the product language and click Next.

The Specify Oracle Home User screen is opened.
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The Oracle home user is different from an Oracle installation user. The Oracle installation 
user is the user who requires administrative privileges to install Oracle products. The 
Oracle home user is used to run the Windows services for the Oracle home.

The Oracle home user can be the Windows built-in account or a Windows user account. 
For enhanced security, Oracle recommends that a standard Windows user account has to be 
chosen as the Oracle home user for a database client installation. If a Windows user 
account is used, it must be a standard Windows user account (not an administrator) and can 
be a local user, a domain user, or a managed services account.

5. Specify the Oracle home user and click Next.

The Specify Installation Location screen is opened.
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6. Specify the installation location for the Oracle base directory and the Oracle home 
directory.

7. Click Next.

?  If the Oracle base location is the same as the user home directory, the following 
warning message appears:

[INS-32008] Oracle base location can't be the same as the user home directory.

?  If the selected Oracle home location is outside of Oracle base, the following warning 
message appears:

[INS-32018] The selected Oracle home is outside of Oracle base.

8. Click Yes to override the warning.

The Available Product Components screen is opened.

Note: If possible, avoid having the same directory for the Oracle Base and 
the Oracle home directory.

Note: If possible, avoid having the Oracle home outside of Oracle base.
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9. Select the following components to install (as shown in the screen above):

?  Oracle Database Utilities

?  Oracle Java Client

?  SQL*Plus

?  Oracle JDBC/THIN Interfaces

?  Oracle Call Interface (OCI)

?  Oracle Programmer

?  Oracle Net

10. Click Next.

The Perform Prerequisites Checks screen is opened, displaying the verification process.
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The Perform Prerequisite Checks screen verifies if your computer meets the minimum 
system requirements to install the desired product. 

Upon completion of the checks, the installer displays the results for review. 

If any of the requirements are not met, the installer displays a list of the failed checks and 
their actual and expected values.
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11. Upon completion, the Finish screen is opened.

12. Click Close to exit the Oracle Client Installer.

Install Database Client Patch

Installation Example for Windows:

unzip p25115951_121020_WINNT.zip
 cd 25115951
 %ORACLE_HOME%\OPatch\opatch.bat apply

Note: UNIX:

The "Fix & Check Again" button and the function to create a fixup script will 
only appear on a UNIX operating system.

You may click the Fix & Check Again button to generate a fixup script.

The nodes on which the prerequisites failed are listed in the Execute Fixup 
Script window. You can run the fixup script as a root user to complete the 
required pre-installation steps.

Using the fixup scripts does not ensure that all the prerequisites for installing 
the Oracle database are satisfied. You must still verify that all the 
pre-installation requirements are met to ensure a successful installation.

Note: The database client of Oracle Database 12cR1 (12.1.0.2) requires the 
following patch (32-bit) to be installed:

- WINDOWS DB BUNDLE PATCH 12.1.0.2.170117 - 25115951

- UNIX Database Patch Set Update 12.1.0.2.170117 - 24732082

Note: If you are on HP-UX platform, please use database client patch 
20051833

Note: Further information and instructions about these database client 
patches can be found in the respective Readme file from the Oracle Patches 
and Updates support website:

- Windows: 
https://updates.oracle.com/Orion/Services/download?type=readme&aru=209
96006

- UNIX example: 
https://updates.oracle.com/Orion/Services/download?type=readme&aru=212
38448

Note: You must use the OPatch utility version 12.1.0.1.2 or later to apply 
this patch.
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Installation Example for UNIX:

$ unzip -d <PATCH_TOP_DIR> p24732082_<121020_UNIX-SYSTEM>.zip
$ cd <PATCH_TOP_DIR>/24732082
$ $ORACLE_HOME/OPatch/opatch apply

Post-Installation Modifications for the Oracle Database 12c

Creating the Database

Before creating the database instance, the database listener needs to be configured.

Configure the Listener
1. Start the Oracle Net Configuration Assistant.

?  Windows

1. Start the Oracle Net Configuration Assistant.

2. Click Start > All Programs > Oracle - OraDb192c_home1 > Configuration and 
Migration Tools > Net Configuration Assistant.

?  UNIX

1. Open a new terminal and start the Oracle Net Services Configuration Tool with the 
following command:

$ORACLE_HOME/bin/netca
The Oracle Net configuration Assistant - Welcome screen is opened.

Note: Ensure that the Oracle home on which you are installing the patch, or 
from which you are rolling back the patch, is Oracle Database 12c Release 
12.1.0.2.0.

Note: This chapter describes the manual creation of the Database schema. 
Keep in mind that on UNIX, only the manual creation can be performed. For 
the automatic creation on a Windows operating system see chapter 
Installation with the Agile e6 Installer.
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2. Select the Listener configuration and click Next.

The Oracle Net configuration Assistant - Listener Configuration, Listener screen is opened.

3. Select Add and click Next.

The Oracle Net configuration Assistant - Listener Configuration, Listener Name screen is 
opened.
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4. Enter the Listener name to be created and click Next.

If you created the Oracle home user with non-Windows-Built-In Account while installing 
oracle database server, the password for the Oracle home user is here required.

5. Click Next.

The Oracle Net configuration Assistant - Listener Configuration, Select Protocols screen is 
opened.

6. Make sure TCP is listed in the Selected Protocols list and click Next.

TCP is the default selection.

The Oracle Net configuration Assistant - Listener Configuration, TCP/IP Protocol screen is 
opened.
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7. Select the standard port number of 1521.

You may choose any port number that has not been used yet.

8. Click Next.

The Oracle Net configuration Assistant - Listener Configuration, More Listeners? screen is 
opened.

9. Select No and click Next.

The Oracle Net configuration Assistant - Listener Configuration Done screen is opened.
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10. Click Next and finish to close the Listener Configuration.

Your database listener is now created and started.

Configuring the Database Net Service Name
This section describes the manual configuration of the Database Net Service Name.

1. Start the Oracle Net Services Configuration Assistant.

?  Windows

Click Start > All Programs > Oracle - OraClient12Home1_32bit > Configuration and 
Migration Tools > Net Configuration Assistant.

?  UNIX

Enter the command: $ORACLE_HOME/bin/netca

The Welcome to the Oracle Net Configuration Assistant screen is opened.

Note: The following instruction is only necessary for the database!

Note: On UNIX, only the manual configuration can be performed. For the 
configuration on a Windows operating system see chapter Installation with 
the Agile e6 Installer.
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2. Select the Local Net Service Name configuration and click Next.

3. Select Add and click Next.

4. Enter the Service Name.
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This is the global database name you provided by the database creation. In the example it 
is plm62.example.com.

5. Click Next.

6. Select the TCP protocol and click Next.

7. Enter the fully qualified host name - where the Oracle database is located and click Next.
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8. Select No, do not test and click Next.

9. Enter the Net Service Name and click Next.

This is the same name as entered above.

10. Select No and click Next.
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The Net service name configuration is completed.

11. Click Next.

12. Click Finish to quit.

Create the Database
The database is created by using the Database Configuration Assistant (DBCA) templates. 
DBCA templates include database options, initialization parameters, and storage information 
for data files, table spaces, control files and redo logs.

Five different templates are predefined to meet different requirements according to the purpose, 
size, and number of users of the Agile e6.2.1.0 database installation.

For additional information on significant database parameters and settings of each template, 
refer to the Hardware Sizing Guide for Agile e6.2.1.0.

1. Refer to the downloaded media pack - Oracle Agile Engineering Data Management 
Application (Release e6.2.1.0).

?  Windows

1. All the templates are in the db_addon\axalant\db_util\oracle\windows\templates 
directory.

2. Copy the required DBCA template file (e.g. plm_prod_medium.dbt) to the 
%ORACLE_HOME%\assistants\dbca\templates directory.

3. Start the Oracle Database Configuration Assistant from the Windows Start menu.

Search for application Database Configuration Assistant and start it.

?  UNIX

1. All the templates are in the addon/db/unix/templates directory.

2. Copy the required DBCA template file (e.g. plm_prod_medium.dbt) to the 
$ORACLE_HOME/assistants/dbca/templates directory.

Note: In all the examples given in this chapter, the name of the Oracle 
Home for Oracle Database installation is OraDb12c_home1. You may use a 
different name in your installation.
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3. Start the Oracle Database Configuration Assistant

$ORACLE_HOME/bin/dbca
The Database Configuration Assistant: Welcome screen is opened.

2. Select Create a Database and click Next.

The Database Configuration Assistant - Creation Mode screen is opened.
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3. Select Advanced Mode and click Next.

The Database Configuration Assistant - Database Template screen is opened.

The template that you have chosen and copied is available in this list.
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4. Select the template you want to use and click Next.

The Database Configuration Assistant - Database Identification screen is opened.

5. Enter the Global database name and database SID.

The default SID is plm62. It is recommended to set the global database name to 
SID.<domain name>; for example, plm62.example.com. But it can also be left with the 
same name as the database SID.

6. Click Next.

The Database Configuration Assistant - Management Options screen is opened.

Note: Do not leave this field blank.
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With Oracle Database 12c the Enterprise Manager (EM) Database Express can be installed 
in two ways:

? EM Database Express

Oracle Enterprise Manager Database Express is a web-based database management 
tool that is built inside each Oracle database. All the SQL commands you normally 
type have been translated into a graphical point-and-click interface. EM Database 
Express even supports RAC database management.

EM Express is not a direct replacement for DB Control. EM Express is built inside the 
database server and there are limitations as to what it can do. EM Express is also 
focused on providing performance management and monitoring functionality, and is 
not meant to be an all around database administration tool.

? EM Cloud Control

Cloud Control provides Web-based management tools for managing individual 
database instances, as well as central management tools for managing your entire 
Oracle environment, including multiple databases, hosts, application servers, and other 
components of your network. It can even be used to manage non-Oracle databases.

For more information about centrally managing the databases, application servers, 
hosts, and other components of your network, see Oracle Enterprise Manager 
Administration Guide. 

7. Select the option Configure Enterprise Manager (EM) Database Express.

The Oracle Configuration Assistant - Database Credentials screen is opened.
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8. Enter passwords for SYS, SYSTEM and click Next.

The Database Configuration Assistant - Network Configuration screen is opened.

Note: It is highly recommended to use different passwords for these 
accounts.

Note: Each password needs to meet the Oracle recommended standards. A 
password should have a minimum of 8 characters. In addition, the password 
must contain at least one upper and one lower case character, and one digit.

Note: If your Oracle home user is not the Windows built-in account, please 
use the password of the Oracle home user for the Windows service 
configuration.
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9. Now you can see the listener you created and configured before in the list with the status 
up. Select it and click Next.

The Database Configuration Assistant - Storage Locations screen is opened.
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10. Select Use Database File Locations from Template.

11. Click the File Location Variables… button.

The File Location Variables screen is opened.

12. Enter the value for the variables.

The values that you have to provide are the directories created, as described in chapter 
Oracle Database Prerequisites (example E:, F:, H:). DBCA will create the subdirectory 
plm62 in the directories where the database data files will be created.

Example: Depending on the selected template, the following table provides information on 
predefined file destination variables.

Note: If missing, please add File Creation Variables as described below.

Variable Description

ORADATA1 Directory for data files of tablespaces EDB, EDB_LOB, EDB_TMPIDX

ORADATA2 Directory for data files of tablespaces EDB_IDX, EDB_TMP

ORADATA3 Directory for data files of temporary tablespace TEMP

ORADATA4 Directory for data files of undo tablespace

ORADATA5 Directory for data files of tablespaces SYSTEM, TOOLS, USERS

ORAARCH Directory for Archive log files

REDO1 Directory for redo log files

REDO2 Directory for redo log files
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The following listing gives values that you can set for the variables when you have 
different number of disks:

Number of Disks Contents

1 There is only one directory - e.g. /data1)

Disk1: ORADATA1, ORADATA2, ORADATA3, ORADATA4, ORADATA5, 
REDO1, REDO2, ORAARCH - all variables will be set to /disk1

2 There are two directories - e.g. /data1, /data2

Disk1: ORADATA1, ORADATA4, ORADATA5, REDO1 - they get the value 
of /data1

Disk2: ORADATA2, ORADATA3, ORAARCH, REDO2 - they get the value 
of /data2

3 Disk1: ORADATA1, ORADATA5

Disk2: ORADATA2, ORADATA4, REDO1

Disk3: ORADATA3, ORAARCH, REDO2

4 Disk1: ORADATA1, REDO1

Disk2: ORADATA2, REDO2

Disk3: ORADATA3, ORAARCH

Disk4: ORADATA4, ORADATA5

5 Disk1: ORADATA1, REDO1

Disk2: ORADATA2, ORAARCH

Disk3: ORADATA3, ORADATA5

Disk4: ORADATA4

Disk5: REDO2

6 Disk1: ORADATA1

Disk2: ORADATA2, ORAARCH

Disk3: ORADATA3

Disk4: ORADATA4

Disk5: ORADATA5, REDO1

Disk6: REDO2

7 Disk1: ORADATA1

Disk2: ORADATA2

Disk3: ORADATA3

Disk4: ORADATA4

Disk5: ORADATA5, ORAARCH

Disk6: REDO1

Disk7: REDO2
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13. Click OK.

14. Deselect the option Specify Flash Recovery Area.

Depending on your backup strategy and used template, archiving can be enabled.

After editing this screen, click OK to return to the Storage Location screen.

15. Click Next.

The Database Configuration Assistant - Database Options screen is opened.

8 Disk1: ORADATA1

Disk2: ORADATA2

Disk3: ORADATA3

Disk4: ORADATA4

Disk5: ORADATA5

Disk6: ORAARCH

Disk7: REDO1

Disk8: REDO2

Note: For a productive database it is highly recommended to archive the 
database. To specify the destination of the archive directory, click the button 
Edit Archive Mode Parameters button (predefined by the variable 
ORAARCH).

Number of Disks Contents
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This screen provides database features as well as the possibility to run custom scripts after 
the database creation.

We do not recommend changing the settings provided by the template.

16. Click Next.

The next screen provides different database parameters. You can navigate to the setting of 
memory, character sets, database sizing, and connection mode. Usually all parameters are 
set by the selected template and you don't need to change them. Experienced users can 
modify some parameters, depending on the database size and number of users.

For complete information on additional parameters, e.g. memory, refer to the Hardware 
Sizing guide for Agile e6.2.1.0.

Note: If you have selected Oracle Application Express for customer 
specific installation, you have to change the initialization parameter max_
string_size to standard. 

After the initial creation of the database, the parameter needs to be changed 
back to extended. 

Please follow the guideline in the Oracle Database documentation 



Post-Installation Modifications for the Oracle Database 12c

Oracle Database 12c 6-39

17. Click All Initialization Parameters button to review all server parameters.

The All Initialization Parameters screen is opened.

Click Show Advanced Parameters. 

Note: Ensure that the value of memory_max_target is greater than the 
value of memory_target.
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18. Click Close and then click Next.

The Database Configuration Assistant - Creation Options screen is opened.

19. Click the Customize Storage Locations button to review the storage parameters for 
database creation.

The Customize Storage screen is opened.
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20. Click Close to return to the Database Configuration Assistant - Creation Options screen.

21. Select Create Database, Save as a Database Template, and Generate Database Creation 
Scripts.

22. Click Next.

The Database Configuration Assistant - Summary screen is opened.



Post-Installation Modifications for the Oracle Database 12c

6-42 Oracle Agile Engineering Data Management/Server Installation Guide on Windows and UNIX for Agile

A summary of the database parameters is shown.

23. Click Finish.

The database creation process is started.

24. When the database creation is done, the summary screen is shown.

The EM database Express URL is listed for your access.

Click Close to finish the process.
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25. Test the database connection with the following command:

sqlplus system@plm62/<SYSTEM password>

Configuring tnsnames.ora and sqlnet.ora

1. Start the Oracle Net Manager.

?  Windows:

Click Start > All Programs > Oracle - OraClient12Home1_32bit > Configuration and 
Migration Tools > Net Manager.

?  UNIX

Enter the command: $ORACLE_HOME/bin/netmgr

2. Expand the view for Local and click on Profile.
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3. On the tab Methods, enter your domain name in the field Default Domain.

4. In the main menu, click File > Save Network Configuration.

5. Click File > Exit.

The sqlnet.ora and tnsnames.ora under $ORACLE_HOME/network/admin/ will be created 
or updated.

Modifying the Oracle Database

Create Directories for the Oracle Data Pump Utility
1. Create a directory which will be used for the Oracle Data Pump Export/Import Utility with 

two subdirectories - system and user (for instance D:\ora_dmp\system; D:\ora_dmp\user).

2. Open an SQLplus session and connect as user 'system'.

sqlplus system/<system password>

3. Run the script ddl_pump_dir.sql.

It is located in the addon/db/sql directory of the downloaded Oracle Agile Engineering 
Data Management Application (Release e6.2.1.0) package.

SQL>@<full path to the file ddl_pump_dir.sql>

4. Enter the path to the main directory created under step 1 (for instance d:\ora_dmp).

Note: This section describes the manual modification of the Database. 
Keep in mind that on UNIX only the manual modification can be performed.
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The script will create two directory objects - one for system users, and one for normal 
users and will give rights for the second directory to user PLM.

Create a Database User and Role
You will need to create the Agile e6.2.1.0 database user and role and provide the necessary 
privileges and quotas. You can do this by using the following commands, or by using the 
Oracle Enterprise Manager Database Control as described in the section below.

You can create AGILE_E_ROLE role and plm schema also by executing the script cre_plm_
usr.sql in the directory …/addon/db/sql.

SQL>@<full path to the file cre_plm_usr.sql>

Username (e.g. PLM) and password have to be provided.

Using SQL to Create a Role  1.Check if the plm role exists.

1. Open an SQLplus session

2. Connect as SYS or SYSTEM.

3. Execute the following command:

select role from dba_roles where role='AGILE_E_ROLE';
2. If string 'AGILE_E_ROLE' is returned, the role exists.

If it exists, skip the role creation and continue with Using SQL to Create a User.

Otherwise, the role has to be created.

3. Use the SQL code below to create the role AGILE_E_ROLE:

CREATE ROLE AGILE_E_ROLE;
GRANT CONNECT TO AGILE_E_ROLE;
GRANT CREATE TABLE TO AGILE_E_ROLE;
GRANT CREATE VIEW TO AGILE_E_ROLE;
GRANT CREATE SYNONYM TO AGILE_E_ROLE;
GRANT CREATE DATABASE LINK TO AGILE_E_ROLE;
GRANT CREATE SEQUENCE TO AGILE_E_ROLE;
GRANT ALTER SESSION TO AGILE_E_ROLE;
GRANT CREATE PROCEDURE TO AGILE_E_ROLE;
GRANT CREATE TRIGGER TO AGILE_E_ROLE;
GRANT ALL ON DIRECTORY ORA_DMP TO AGILE_E_ROLE;

Using SQL to Create a User  1.Use the SQL code below to create the plm schema (e.g. 
PLM):

CREATE USER PLM
IDENTIFIED BY <PASSWORD>
DEFAULT TABLESPACE "EDB"
TEMPORARY TABLESPACE "TEMP"
PROFILE DEFAULT
QUOTA UNLIMITED ON "EDB"
QUOTA UNLIMITED ON "EDB_IDX"
QUOTA UNLIMITED ON "EDB_TMP"
QUOTA UNLIMITED ON "EDB_TMPIDX"
QUOTA UNLIMITED ON "EDB_LOB"
ACCOUNT UNLOCK;
GRANT "AGILE_E_ROLE" TO PLM;
ALTER USER PLM DEFAULT ROLE AGILE_E_ROLE;

Using Enterprise Manager Database Express to Create a User  How to find the 
port on which EM Express is configured:
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? When dbca completes, it indicates the port on which EM Express is configured.

? If that information is no longer available, there are two ways to find the HTTP/HTTPS port 
for EM Express:

> lsnrctl status | grep HTTP 
(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)(HOST=xxx.us.oracle.com)(PORT=5500))(Secur
ity=(my_wallet directory=/u01/oracle/app/oracle/admin/plm62/xdb_
wallet))(Presentation=HTTP)(Session=RAW))

or from SQL*Plus:

SQL> select dbms_xdb.getHttpPort() from dual; 
GETHTTPPORT 
----------- 
8080 
SQL> select dbms_xdb_config.getHttpsPort() from dual; 
GETHTTPSPORT 
------------ 
5500

You can access the Oracle Enterprise Manager Database Express as follows:

1. Open your browser and enter the following URL: 

https://<hostname>:<port>/em

2. Enter your user credentials and click Login.

3. In the top menu bar, click Security and then select Users.

4. Click Create User on the user list.

5. Insert a user name and password in the pop-up dialog.
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6. Assign default and temporary table space for this user.

7. From the list with Available Roles, select the role AGILE_E_ROLE.

The role AGILE_E_ROLE was created in the previous section "Create a Database User 
and Role."

8. Click Move.

The role is moved to the Selected Roles list.

Click OK.

9. Click the newly created user and open the tab Quotas.
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10. Assign unlimited quota to EDB, EDB_IDX, EDB_LOB, EDB_TMP, and EDB_TMPIDX.

The user creation is finished.

Import the Database Dump
Import the Agile e6.2.1.0 dump, using the following commands, and then check the log file for 
errors.

?  Windows

Make sure that the variable NLS_LANG is set to AMERICAN_ AMERICA.AL32UTF8.
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Check the registry for the value of the variable NLS_LANG - HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\KEY_<12c installation>

?  UNIX

Make sure that the correct value is set for the environment variable NLS_LANG (value 
from the file csh_ORA12.1.0 - AMERICAN_AMERICA.WE8MSWIN1252).

1. Start the import.

imp username/pass@plm61 file=plm62.dmp log=plm61.log buffer=500000 commit=y 
statistics=none full=y

Compile All Invalid Objects in Schema PLM
After importing the Agile e6.2.1.0 dump, some objects might be invalid. This can be verified 
by the following way:

1. Open an SQLplus session and connect as 'sys' - as sysdba.

sqlplus sys/<sys password> as sysdba
SQL> select count(*) from dba_objects where status <> 'VALID' and owner='PLM';
If the returned message is 'no rows selected', then you have no invalid objects.

2. 2. Otherwise, execute the script utlrp.sql.

The script will compile all invalid objects in the database.

SQL> @?/rdbms/admin/utlrp.sql
3. Verify that there are no invalid objects:

SQL> select count(*) from dba_objects where status <> 'VALID' and owner='PLM';

Gather Statistics
In Oracle 12c, the default value for the OPTIMIZER_MODE initialization parameter is ALL_
ROWS, which means that a cost-based approach will be used for all SQL statements. Oracle 
highly recommends creating statistics in order to avoid performance losses. This should be 
done after the dump import and has to be repeated periodically.

1. Calculate statistics of all tables and indexes in db schema PLM:

Note: username/ pass are the name and the password of the user you 
created in the database.

commit=y Rollback segments cannot get too small

statistics=n No statistics will be created

buffer=500000 Necessary for lobs, better performance

full=y Imports full dump, even if the dump was exported by different users

Note: You can import only your own e6 dmp files which were created in a 
database in which the initialization parameter max_string_size =standard. Be 
aware that the e6 database has set this parameter to extended. Please use data 
pump utilities (expdp, impdp) instead. For more details, see Oracle 12c 
Database documentation.

All standard dmp files delivered on Oracle edelivery for e6.2.1.0 can be 
imported with imp/exp utility.
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SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS('PLM',CASCADE =>true);

For more information about statistics management please refer to the Oracle Database 
manuals.

Problems During Database Creation
When having problems with the database creation, perform the following checks:

?  Database creation logs: ${ORACLE_BASE}/cfgtools/dbca/<db name>

?  Instance Parameter file: ${ORACLE_BASE}/admin/<db name>/pfile/init.ora

?  Instance SPFILE: ${ORACLE_HOME}/dbs/spfile<db name>.ora

?  Database Diagnostics: ${ORACLE_BASE}/diag/rdbms/<db name>/<db name>

?  Network configuration: ${ORACLE_HOME}/network/admin/*.ora

Note: Statistic information can be viewed, e.g. in user_tables and user_
indexes. These views provide information about average width of the row and 
number of rows.
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Oracle Database Prerequisites 19c

Windows
Create the directories/drives for the distribution of the data files depending on the number of 
disks prepared for the Oracle installation.

For instance, if you have prepared 3 disks -

?  E:\

?  F:\

?  H:\

The drive letters E:\, F:\, and H:\ are just examples. Subdirectories will be created later in these 
directories by either:

?  Manual installation

–  Installing Oracle Database Server

–  Installing Oracle Database Client

UNIX

Setting Up an Oracle Operating System User
Several operating system groups and users might have to be installed, depending on:

?  If Oracle software is installed on this system the first time

?  Installed products

For complete information on how to set up an Oracle Operating System User, refer to the 
Oracle Database Software documentation.

Note: This chapter describes prerequisites for installing the Oracle 
Database client and server on all supported operating systems.
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To create an Oracle account:

1. Create the dba group for the machine on which Oracle is being installed:

groupadd -g 502 dba

2. Create an Oracle user "oracle" with the following parameter and execute the following 
command.

?  Home directory "/opt/oracle"

?  Login shell "/bin/csh"

?  Member of the group "dba"

useradd -u 502 -g dba -d /opt/oracle -s /bin/csh oracle

3. Log into Oracle and create the subdirectories:

?  /opt/oracle/bin

?  /opt/oracle/product

?  /opt/oracle/product/12.0.1

4. Create the directory, links, and mount points for distribution of the data files, depending on 
the number of disks prepared for the Oracle installation.

For instance, if you have prepared 3 disks:

?  …/data1

?  …/data2

?  …/data3

The names data1, data2, and data3 are just examples.

Subdirectories will be created later in these directories by the database:

?  Manual installation

– § Installing Oracle Database Server

– § Installing Oracle Database Client

?  Automatic installation

– § Installation with the Agile e6 Installer

Note: On AIX you have to use the following command instead:

mkgroup id=502 dba

Note: This is also value for ORACLE_BASE. The directory must be 
created first.

Note: If ORACLE_BASE is not set to /opt/oracle, the above mentioned 
subdirectories have to be created in the designated directory.
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Free Up Disk Space in the /tmp Directory
The Oracle Installer needs some temporary disk space during the installation in /tmp. Check the 
required space in tmp directory under Hardware Requirements for the relevant operating 
system.

To determine the amount of free disk space available in the /tmp directory, enter the following 
command in a command shell:

df /tmp

If the space available in the /tmp directory is less than required, complete one of the following 
steps:

1. Delete unnecessary files from the /tmp directory to achieve the required disk space.

2. Set the TEMP and TMPDIR environment variables when setting the Oracle user's 
environment (described later).

3. Extend the file system that contains the /tmp directory. If necessary, contact your system 
administrator for information about extending file systems.

If you have determined that the /tmp directory had insufficient free disk space when checking 
the hardware requirements, enter the following commands to set the TEMP and TMPDIR 
environment variables. Specify a directory on a file system with sufficient free disk space.

?  In a Bourne, Bash, or Korn shell:

TEMP=/directory
TMPDIR=/directory
export TEMP TMPDIR

?  In a command shell:

setenv TEMP /directory
setenv TMPDIR /directory

Installing Oracle Database Server 19c
This chapter describes the manual installation of the Oracle Database Server. 

Start the Oracle Database installation

1. Run the installer from the downloaded Oracle Installation Media 

Windows

Run setup.exe

UNIX

Note: For recommended disk layout, please check the Hardware Sizing 
Guide for Agile e6.2.1.0

Note: For disk space requirements check the specific Quick Installation 
Guide Section provided with the Operating System.

Note: If you have already installed Oracle database client (32-bit) on the 
same machine, please restart it before installing the Oracle database server.
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Log in as the oracle user and navigate to the database directory. Start the Oracle Universal 
Installer with the following command:

./runInstaller

The Select Configuration Option screen is opened. 

2. Choose "Set up Software Only" and click Next.

3. In the Database Installation Options, select "Single instance database installation" and click 
Next

Note: You must extract the image software (<DB server installer>.zip) into 
the directory where you want your Oracle Database home to be located, and 
then run the Oracle Database Setup Wizard to start the Oracle Database 
installation and configuration. Oracle recommends that the Oracle home 
directory path you create is in compliance with the Oracle Optimal Flexible 
Architecture recommendations. 
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4. For the database edition, please choose "Enterprise Edition and click Next

Note: The Real Application Cluster database installation is not covered 
under this guide.

Note: Depending on the installer package, there may be more options under 
this step but we will only cover Enterprise Edition installation
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5. Windows Only

The Oracle Home User is different from an Oracle Installation User. The Oracle 
Installation User is the user who requires administrative privileges to install Oracle 
products. The Oracle Home User is used to run the Windows services for the Oracle Home.

The Oracle Home User can be the Windows built-in account or a Windows User Account. 
For enhanced security, Oracle recommends that a standard Windows User Account be 
chosen as the Oracle Home User for a database server installation. If a Windows user 
account is used, it must be a standard Windows user account (not an administrator) and for 
single instance database installations can be a local user, a domain user, or a managed 
services account. For Oracle Database RAC installations, the Windows user account must 
be a domain user.

Specify the Oracle home user and click Next.

6. Specify the installation location for the Oracle Base directory and click Next
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7. UNIX ONLY. 
Specify an Inventory directory and the proper Group to handle the orainventory directory 
and click Next

8. UNIX ONLY. 
Set the corresponding group that will be responsible for each item and click Next.
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9. UNIX ONLY. 
Define the user with root privileges and click Next.

10. Wait for prerequisite checks and the summary page. 
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11. Click Install

12. Wait for the installation to be finished and click Close.

Note: UNIX Only

The "Fix & Check Again" button and the function to create a Fixup Script 
will only appear on a UNIX operating system.

You may click the Fix & Check Again button to generate a fixup script.

The nodes on which the prerequisites failed are listed in the Execute Fixup 
Script window. You can run the fixup script as a root user to complete the 
required pre-installation steps.

For manual fixing of the pre-installation steps, you can refer to this link: 
https://docs.oracle.com/en/database/oracle/oracle-database/19/ladbi/completi
ng-preinstallation-tasks-manually.html#GUID-54959149-E611-48EC-BDDF-
F379E8B35C97
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Installing Oracle Database Client

1. The first step of the installation is different for Windows and UNIX.

?  Windows

•   Run “setup.exe” from the downloaded Oracle Installation Media.

?  UNIX

Log in as the Oracle user and start the Oracle Universal Installer with the following 
command:

./runInstaller
The Select Installation Type screen is opened.

Note: This chapter describes the manual installation of the Oracle Database 
client. Keep in mind that only the manual installation can be performed for 
Oracle 19c Database client.

Note: If you have already installed Oracle database server on the same 
machine, please restart it before installing the Oracle database client.

Note: The 32-bit Oracle client must be installed on the same machine 
where Agile e6.2.1.0 is installed.
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2. Select “Custom” and click “Next”.

The “Specify Oracle Home User screen” is opened. 
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•   The Oracle home user is different from an Oracle installation user. The Oracle 
installation user is the user who requires administrative privileges to install Oracle 
products. The Oracle home user is used to run the Windows services for the Oracle home. 
The Oracle home user can be the Windows built-in account or a Windows user account. 
For enhanced security, Oracle recommends that a standard Windows user account has to be 
chosen as the Oracle home user for a database client installation. If a Windows user 
account is used, it must be a standard Windows user account (not an administrator) and can 
be a local user, a domain user, or a managed services account.

3. Specify the Oracle home user and click “Next”.

The “Specify Installation Location” screen is opened.
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4. Specify the installation location for the Oracle base directory and the Oracle home 
directory.

5. Click “Next”.

a.   If the Oracle base location is the same as the user home directory, the following   
warning message appears: [INS-32008] Oracle base location can't be the same as the user 
home directory.

•   Note: If possible, avoid having the same directory for the Oracle Base and the 
Oracle home directory.

b.   If the selected Oracle home location is outside of Oracle base, the following warning 
message appears: [INS-32018] The selected Oracle home is outside of Oracle base.

•   Note: If possible, avoid having the Oracle home outside of Oracle base.

6. Click “Yes” to override the warning.
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7. Select the following components to install (as shown in the screen above):

•   Oracle Database Utilities

•   Oracle Java Client

•   SQL*Plus

•   Oracle JDBC/THIN Interfaces

•   Oracle Call Interface (OCI)

•   Oracle Programmer

•   Oracle Net

8. Click “Next”.

The Perform Prerequisites Checks screen is opened, displaying the verification process. 
The Perform Prerequisite Checks screen verifies if your computer meets the minimum 
system requirements to install the desired product.

Upon completion of the checks, the installer displays the results for review. If any of the 
requirements are not met, the installer displays a list of the failed checks and their actual 
and expected values.
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Note for UNIX:

-   The “Fix & Check Again” button and the function to create a fixup script will only 
appear on a UNIX operating system.

-   You may click the “Fix & Check Again” button to generate a fixup script.

-   The nodes on which the prerequisites failed are listed in the “Execute Fixup Script” 
window. You can run the fixup script as a root user to complete the required 
pre-installation steps.

-   Using the fixup scripts does not ensure that all the prerequisites for installing the Oracle 
database are satisfied. You must still verify that all the pre-installation requirements are 
met to ensure a successful

9. Upon completion, the “Finish screen” is opened.

10. Click “Close” to exit the Oracle Client Installer.

Installing Oracle Database Client Patch
The database client of Oracle Database 19c (19.3.0) requires the following patch (32-bit) to be 
installed:

- WINDOWS DATABASE BUNDLE PATCH 19.13.0.0.211019 - 33155330 

? - UNIX DATABASE RELEASE UPDATE 19.13.0.0.0 - 33192793
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Installation Example for Windows:

unzip p33155330_190000_WINNT.zip

cd 33155330

%ORACLE_HOME%\OPatch\opatch.bat apply

Installation Example for UNIX:

$ unzip -d <PATCH_TOP_DIR> p33192793_190000__<UNIX-SYSTEM>.zip

$ cd <PATCH_TOP_DIR>/33192793

$ $ORACLE_HOME/OPatch/opatch apply

Post-Installation Configuration

NTLM is no longer enabled by default in 19c

Upon using the e6 server deployed in a Windows Server, you may encounter an "Incorrect 
Username or Password" in e6 Java Client. This indicates that e6 application server is 
encountering ORA-12638: Credential retrieval failed(visible in the C server logs). This error is 
introduced due to NTLM being no longer enabled by default in 19c while your Windows 
Servers are still using NTLM as Authentication Protocol.

The default value for NO_NTLM is now TRUE in 19c. If NTLM is still used, please explicitly 
add SQLNET.NO_NTLM=FALSE in $ORACLE_HOME/network/admin/sqlnet.ora on both 
client and server side. DB server requires restart if this parameter is updated (refer to MOS 
Note DOC ID  2757734.1 for details)

Note: Further information and instructions about these database client 
patches can be found in the respective Readme file from the Oracle Patches 
and Updates support website.

Note: You must use the OPatch utility version 12.2.0.1.27 or later to apply 
this patch.  The readme of the database patch provides the download link for 
the necessary OPatch update.

Note: Ensure that the Oracle home on which you are installing the patch, or 
from which you are rolling back the patch, is Oracle Database 19c Release 
19.3.0

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=178097255316687&id=2757734.1
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Post-Installation Modifications for the Oracle Database 19c

Creating the Database

Before creating the database instance, the database listener needs to be configured.

Configure the Listener
1. Start the Oracle Net Configuration Assistant.

?  Windows

1. Start the Oracle Net Configuration Assistant.

2. Click Start > All Programs > Oracle - OraDb19c_home1 > Configuration and 
Migration Tools > Net Configuration Assistant.

?  UNIX

1. Open a new terminal and start the Oracle Net Services Configuration Tool with the 
following command:

$ORACLE_HOME/bin/netca
The Oracle Net configuration Assistant - Welcome screen is opened.

2. Select the Listener configuration and click Next.

The Oracle Net configuration Assistant - Listener Configuration, Listener screen is opened.

Note: This chapter describes the manual creation of the Database schema. 
Keep in mind that only the manual creation can be performed for Oracle 
Database 19c.
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3. Select Add and click Next.

The Oracle Net configuration Assistant - Listener Configuration, Listener Name screen is 
opened.

4. Enter the Listener name to be created and click Next.

If you created the Oracle home user with non-Windows-Built-In Account while installing 
oracle database server, the password for the Oracle home user is here required.

5. Click Next.

The Oracle Net configuration Assistant - Listener Configuration, Select Protocols screen is 
opened.
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6. Make sure TCP is listed in the Selected Protocols list and click Next.

TCP is the default selection.

The Oracle Net configuration Assistant - Listener Configuration, TCP/IP Protocol screen is 
opened.

7. Select the standard port number of 1521.

You may choose any port number that has not been used yet.

8. Click Next.

The Oracle Net configuration Assistant - Listener Configuration, More Listeners? screen is 
opened.
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9. Select No and click Next.

The Oracle Net configuration Assistant - Listener Configuration Done screen is opened.

10. Click Next and finish to close the Listener Configuration.

Your database listener is now created and started.

Configuring the Database Net Service Name
This section describes the manual configuration of the Database Net Service Name.

1. Start the Oracle Net Services Configuration Assistant.

?  Windows

Note: The following instruction is only necessary for the database!

Note: On UNIX, only the manual configuration can be performed. For the 
configuration on a Windows operating system see chapter Installation with 
the Agile e6 Installer.
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Click Start > All Programs > Oracle - OraClient12Home1_32bit > Configuration and 
Migration Tools > Net Configuration Assistant.

?  UNIX

Enter the command: $ORACLE_HOME/bin/netca

The Welcome to the Oracle Net Configuration Assistant screen is opened.

2. Select the Local Net Service Name configuration and click Next.

3. Select Add and click Next.
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4. Enter the Service Name.

This is the global database name you provided by the database creation. In the example it 
is plm62.example.com.

5. Click Next.

6. Select the TCP protocol and click Next.
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7. Enter the fully qualified host name - where the Oracle database is located and click Next.

8. Select No, do not test and click Next.

9. Enter the Net Service Name and click Next.

This is the same name as entered above.
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10. Select No and click Next.

The Net service name configuration is completed.

11. Click Next.

12. Click Finish to quit.

Create the Database
The database is created by using the Database Configuration Assistant (DBCA) templates. 
DBCA templates include database options, initialization parameters, and storage information 
for data files, table spaces, control files and redo logs.

Five different templates are predefined to meet different requirements according to the purpose, 
size, and number of users of the Agile e6.2.1.0 database installation.

For additional information on significant database parameters and settings of each template, 
refer to the Hardware Sizing Guide for Agile e6.2.1.0.

Note: In all the examples given in this chapter, the name of the Oracle 
Home for Oracle Database installation is OraDb19c_home1. You may use a 
different name in your installation.
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1. Refer to the downloaded media pack - Oracle Agile Engineering Data Management 
Application (Release e6.2.1.0) RUP2 or later.

?  Windows

1. All the templates are in the addon\db\windows\templates directory

2. Copy the required DBCA template file (e.g. plm_prod_medium.dbt) to the 
%ORACLE_HOME%\assistants\dbca\templates directory.

3. Start the Oracle Database Configuration Assistant from the Windows Start menu.

Search for application Database Configuration Assistant and start it.

?  UNIX

1. All the templates are in the addon\db\unix\templates directory.

2. Copy the required DBCA template file (e.g. plm_prod_medium.dbt) to the 
$ORACLE_HOME/assistants/dbca/templates directory.

3. Start the Oracle Database Configuration Assistant

$ORACLE_HOME/bin/dbca
2. Select Create a Database and click Next.

The Database Configuration Assistant - Creation Mode screen is opened.

3. Select Advanced Mode and click Next.
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The Database Configuration Assistant - Database Deployment Type screen is opened.

4. Select the template you want to use and click Next. 

The template that you have chosen and copied is available in this list.

Minimum hardware requirements should be met depending on which configuration you 
choose.

The Database Configuration Assistant - Database Identification screen is opened.

5. Enter the Global database name and database SID. and click Next 
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The default SID is plm62. It is recommended to set the global database name to 
SID.<domain name>; for example, plm62.example.com. But it can also be left with the 
same name as the database SID.

6. Select "Use template file for database storage attributes" and click "File location variables.

7. Enter the value for the variables and click OK.

Note: Do not leave this field blank.
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The values that you have to provide are the directories created, as described in chapter 
Oracle Database Prerequisites (example E:, F:, H:). DBCA will create the subdirectory 
plm62 in the directories where the database data files will be created.

Example: Depending on the selected template, the following table provides information on 
predefined file destination variables.

The following listing gives values that you can set for the variables when you have 
different number of disks:

Note: If missing, please add File Creation Variables as described below.

Variable Description

ORADATA1 Directory for data files of tablespaces EDB, EDB_LOB, EDB_TMPIDX

ORADATA2 Directory for data files of tablespaces EDB_IDX, EDB_TMP

ORADATA3 Directory for data files of temporary tablespace TEMP

ORADATA4 Directory for data files of undo tablespace

ORADATA5 Directory for data files of tablespaces SYSTEM, TOOLS, USERS

ORAARCH Directory for Archive log files

REDO1 Directory for redo log files

REDO2 Directory for redo log files
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8. Deselect the option Specify Flash Recovery Area.

Number of Disks Contents

1 There is only one directory - e.g. /data1)

Disk1: ORADATA1, ORADATA2, ORADATA3, ORADATA4, ORADATA5, 
REDO1, REDO2, ORAARCH - all variables will be set to /disk1

2 There are two directories - e.g. /data1, /data2

Disk1: ORADATA1, ORADATA4, ORADATA5, REDO1 - they get the value 
of /data1

Disk2: ORADATA2, ORADATA3, ORAARCH, REDO2 - they get the value 
of /data2

3 Disk1: ORADATA1, ORADATA5

Disk2: ORADATA2, ORADATA4, REDO1

Disk3: ORADATA3, ORAARCH, REDO2

4 Disk1: ORADATA1, REDO1

Disk2: ORADATA2, REDO2

Disk3: ORADATA3, ORAARCH

Disk4: ORADATA4, ORADATA5

5 Disk1: ORADATA1, REDO1

Disk2: ORADATA2, ORAARCH

Disk3: ORADATA3, ORADATA5

Disk4: ORADATA4

Disk5: REDO2

6 Disk1: ORADATA1

Disk2: ORADATA2, ORAARCH

Disk3: ORADATA3

Disk4: ORADATA4

Disk5: ORADATA5, REDO1

Disk6: REDO2

7 Disk1: ORADATA1

Disk2: ORADATA2

Disk3: ORADATA3

Disk4: ORADATA4

Disk5: ORADATA5, ORAARCH

Disk6: REDO1

Disk7: REDO2

8 Disk1: ORADATA1

Disk2: ORADATA2

Disk3: ORADATA3

Disk4: ORADATA4

Disk5: ORADATA5

Disk6: ORAARCH

Disk7: REDO1

Disk8: REDO2
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Depending on your backup strategy and used template, archiving can be enabled.

9. Enable archive mode parameters Option and change any settings. Click OK

The "Fast Recovery Option" page is reopened and you can see the listener you created and 
configured before in the list with the status up.

Note: For a productive database it is highly recommended to archive the 
database. To specify the destination of the archive directory, click the button 
Edit Archive Mode Parameters button (predefined by the variable 
ORAARCH).



Post-Installation Modifications for the Oracle Database 19c

Oracle Database 19c 7-31

10. Select the listener and click Next.

This screen provides database features as well as the possibility to run custom scripts after 
the database creation.

We do not recommend changing the settings provided by the template. 

11. Review and if experienced adapt the database parameters and click Next

The next screen provides different database parameters. You can navigate to the setting of 
memory, character sets, database sizing, and connection mode. Usually all parameters are 
set by the selected template and you don't need to change them. 

Experienced users can modify some parameters, depending on the database size and 
number of users.For complete information on additional parameters, e.g. memory, refer to 
the Hardware Sizing guide for Agile e6.2.0.0.



Post-Installation Modifications for the Oracle Database 19c

7-32 Oracle Agile Engineering Data Management/Server Installation Guide on Windows and UNIX for Agile

12. Select the option Choose Configure Enterprise Manager (EM) database express and choose 
the port where you will deploy the EM dashboard and click Next. 

EM Database Express Port is the https port to open express console: 
https://<hostname>:<port>/em//**

The Database Configuration Assistant - Specify User Credentials is opened.

13. Set your administrative user passwords. 

? It is highly recommended to use different passwords for these accounts.

? We recommended each password to meet the Oracle recommended standards. A 
password should have minimum of 8 characters in length. In addition, the password 
must contain at least one upper case character, one lower case character and one digit.

? If your oracle home user is not the windows built-in account, please give the password 
of oracle home user for the windows service configuration.
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14. Select "Save as a database template" if you want to save the template currently configured. 
This will make future installation faster and click on All Initialization Parameters button to 
review all server parameters.

The All Initialization Parameters screen is opened.

15. Click on Show Advanced Parameters and review parameters listed. Select close. 
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16.  Click on Customize Storage Locations to review the storage parameters for database 
creation and click Close.

The Database Configuration Assistant - Summary screen is opened.

17. Proceed to the "Summary" window for the final review and Click on "Finish" to start the 
database creation.

Note: To be sure the value of memory_max_target has to be greater than the value 
of memory_target.



Post-Installation Modifications for the Oracle Database 19c

Oracle Database 19c 7-35

Wait for the full database setup to finish. Once finished, a summary will pop-up. At this 
point, installation is now successful and you can now close the DBCA

18. Test the database connection with the following command:

sqlplus system@plm62/<SYSTEM password>

Configuring tnsnames.ora and sqlnet.ora

1. Start the Oracle Net Manager.

?  Windows:

Click Start > All Programs > Oracle - OraClient12Home1_32bit > Configuration and 
Migration Tools > Net Manager.

?  UNIX

Enter the command: $ORACLE_HOME/bin/netmgr

2. Expand the view for Local and click on Profile.
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3. On the tab Methods, enter your domain name in the field Default Domain.

4. In the main menu, click File > Save Network Configuration.

5. Click File > Exit.

The sqlnet.ora and tnsnames.ora under $ORACLE_HOME/network/admin/ will be created 
or updated.

Modifying the Oracle Database

Create Directories for the Oracle Data Pump Utility
1. Create a directory which will be used for the Oracle Data Pump Export/Import Utility with 

two subdirectories - system and user (for instance D:\ora_dmp\system; D:\ora_dmp\user).

2. Open an SQLplus session and connect as user 'system'.

sqlplus system/<system password>

3. Run the script ddl_pump_dir.sql.

It is located in the addon/db/sql directory of the downloaded Oracle Agile Engineering 
Data Management Application (Release e6.2.1.0) package.

SQL>@<full path to the file ddl_pump_dir.sql>

4. Enter the path to the main directory created under step 1 (for instance d:\ora_dmp).

Note: This section describes the manual modification of the Database. 
Keep in mind that on UNIX only the manual modification can be performed.
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The script will create two directory objects - one for system users, and one for normal 
users and will give rights for the second directory to user PLM.

Create a Database User and Role
You will need to create the Agile e6.2.1.0 database user and role and provide the necessary 
privileges and quotas. You can do this by using the following commands, or by using the 
Oracle Enterprise Manager Database Control as described in the section below.

You can create AGILE_E_ROLE role and plm schema also by executing the script cre_plm_
usr.sql in the directory …/addon/db/sql.

SQL>@<full path to the file cre_plm_usr.sql>

Username (e.g. PLM) and password have to be provided.

Using SQL to Create a Role  1.Check if the plm role exists.

1. Open an SQLplus session

2. Connect as SYS or SYSTEM.

3. Execute the following command:

select role from dba_roles where role='AGILE_E_ROLE';
2. If string 'AGILE_E_ROLE' is returned, the role exists.

If it exists, skip the role creation and continue with Using SQL to Create a User.

Otherwise, the role has to be created.

3. Use the SQL code below to create the role AGILE_E_ROLE:

CREATE ROLE AGILE_E_ROLE;
GRANT CONNECT TO AGILE_E_ROLE;
GRANT CREATE TABLE TO AGILE_E_ROLE;
GRANT CREATE VIEW TO AGILE_E_ROLE;
GRANT CREATE SYNONYM TO AGILE_E_ROLE;
GRANT CREATE DATABASE LINK TO AGILE_E_ROLE;
GRANT CREATE SEQUENCE TO AGILE_E_ROLE;
GRANT ALTER SESSION TO AGILE_E_ROLE;
GRANT CREATE PROCEDURE TO AGILE_E_ROLE;
GRANT CREATE TRIGGER TO AGILE_E_ROLE;
GRANT ALL ON DIRECTORY ORA_DMP TO AGILE_E_ROLE;

Using SQL to Create a User  1.Use the SQL code below to create the plm schema (e.g. 
PLM):

CREATE USER PLM
IDENTIFIED BY <PASSWORD>
DEFAULT TABLESPACE "EDB"
TEMPORARY TABLESPACE "TEMP"
PROFILE DEFAULT
QUOTA UNLIMITED ON "EDB"
QUOTA UNLIMITED ON "EDB_IDX"
QUOTA UNLIMITED ON "EDB_TMP"
QUOTA UNLIMITED ON "EDB_TMPIDX"
QUOTA UNLIMITED ON "EDB_LOB"
ACCOUNT UNLOCK;
GRANT "AGILE_E_ROLE" TO PLM;
ALTER USER PLM DEFAULT ROLE AGILE_E_ROLE;
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Import the Database Dump
Import the Agile e6.2.1.0 dump, using the following commands, and then check the log file for 
errors.

?  Windows

Make sure that the variable NLS_LANG is set to AMERICAN_ AMERICA.AL32UTF8.

Check the registry for the value of the variable NLS_LANG - HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\KEY_<12c installation>

?  UNIX

Make sure that the correct value is set for the environment variable NLS_LANG (value 
from the file csh_ORA12.1.0 - AMERICAN_AMERICA.WE8MSWIN1252).

1. Start the import.

imp username/pass@plm61 file=plm62.dmp log=plm61.log buffer=500000 commit=y 
statistics=none full=y

Compile All Invalid Objects in Schema PLM
After importing the Agile e6.2.1.0 dump, some objects might be invalid. This can be verified 
by the following way:

1. Open an SQLplus session and connect as 'sys' - as sysdba.

sqlplus sys/<sys password> as sysdba
SQL> select count(*) from dba_objects where status <> 'VALID' and owner='PLM';
If the returned message is 'no rows selected', then you have no invalid objects.

2. Otherwise, execute the script utlrp.sql.

The script will compile all invalid objects in the database.

SQL> @?/rdbms/admin/utlrp.sql
3. Verify that there are no invalid objects:

SQL> select count(*) from dba_objects where status <> 'VALID' and owner='PLM';

Note: username/ pass are the name and the password of the user you 
created in the database.

commit=y Rollback segments cannot get too small

statistics=n No statistics will be created

buffer=500000 Necessary for lobs, better performance

full=y Imports full dump, even if the dump was exported by different users

Note: You can import only your own e6 dmp files which were created in a 
database in which the initialization parameter max_string_size =standard. Be 
aware that the e6 database has set this parameter to extended. Please use data 
pump utilities (expdp, impdp) instead. For more details, see Oracle 19c 
Database documentation.

All standard dmp files delivered on Oracle edelivery for e6.2.1.0 can be 
imported with imp/exp utility.
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Gather Statistics
In Oracle 19c, the default value for the OPTIMIZER_MODE initialization parameter is ALL_
ROWS, which means that a cost-based approach will be used for all SQL statements. Oracle 
highly recommends creating statistics in order to avoid performance losses. This should be 
done after the dump import and has to be repeated periodically.

1. Calculate statistics of all tables and indexes in db schema PLM:

SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS('PLM',CASCADE =>true);

For more information about statistics management please refer to the Oracle Database 
manuals 
(https://docs.oracle.com/en/database/oracle/oracle-database/19/refrn/OPTIMIZER_
MODE.html#GUID-DE448A8A-992F-4BAB-9302-A020039641E5).

Problems During Database Creation
When having problems with the database creation, perform the following checks:

?  Database creation logs: ${ORACLE_BASE}/cfgtools/dbca/<db name>

?  Instance Parameter file: ${ORACLE_BASE}/admin/<db name>/pfile/init.ora

?  Instance SPFILE: ${ORACLE_HOME}/dbs/spfile<db name>.ora

?  Database Diagnostics: ${ORACLE_BASE}/diag/rdbms/<db name>/<db name>

?  Network configuration: ${ORACLE_HOME}/network/admin/*.ora

Note: Statistic information can be viewed, e.g. in user_tables and user_
indexes. These views provide information about average width of the row and 
number of rows.
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8Installing Oracle WebLogic Server

Windows Prerequisites
There are no prerequisites referring only to Windows.

UNIX Prerequisites

The Java on HP-UX and Oracle Solaris must be started with the -d64 option. If the option -d64 
is not supplied, the Java executable starts in its default 32-bit mode.

The -d64 option is supported on all operating systems, so you can always use it while installing 
the Oracle WebLogic Server.

Note: This chapter describes the manual installation of the Oracle 
WebLogic Server. Keep in mind that on UNIX only the manual installation 
can be performed. For the installation on a Windows operating system with 
the Agile e6 Installer see chapter Installation with the Agile e6 Installer.

Note: Before you begin with the installation of Oracle WebLogic Server, 
note the following:

 The generic Oracle WebLogic Installer must be started with the installed 
64-bit Java 8 JDK.

 The Generic Oracle WebLogic Server (jar file) cannot be started with 32-bit 
JVM.

Note: Installing the WebLogic Server and the EDM Server on the same 
UNIX server machine, requires special attention:

If the operating system user for the WebLogic installation is different to the 
operating system user for the EDM Server installation, a component based 
installation is required. For further information please refer to the chapter 
Component Based Installation.
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Generic Prerequisites

Setting the Java_Home environment and check Java Version

1. Before starting the installation, ensure that the bin directory of the appropriate JDK, used 
to run the installer, is at the beginning of the PATH variable, or called with the full path to 
the Java executable.

2. Set the JAVA_HOME environment variable to the installed 64-bit Java Development 
environment.

?  Windows

set JAVA_HOME=C:\Program Files\Java\jdk1.8.0_<update_number>
?  UNIX

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>
3. Check the Java version with:

? Windows

 %JAVA_HOME%\bin\java -d64 -version
? UNIX

$JAVA_HOME/bin/java -d64 -version
?  If you try to start a 32-bit Java, or start a 64-bit Java on a 32-bit operating system, this 

command will fail.

?  In this case, run the installer as follows:

– Windows

%JAVA_HOME%\bin\java -d64 -jar fmw_12.2.1.3.0_wls.jar
– UNIX

$JAVA_HOME/bin/java -d64 -jar fmw_12.2.1.3.0_wls.jar

Installation
1. Run the Oracle WebLogic installer file.

On UNIX the Installation Inventory Setup screen may open.

The following screen will only open if the current user has no write access to the Inventory 
Directory or it the Inventory Directory does not exists yet

Note: This setting is important, because the WebLogic server will use this 
Java based on this setting.
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Note: The following screens is opened for all Operating Systems
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2. Click Next.

The Installation Location screen is opened.
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3. Specify the new Oracle Home Directory path and click Next.

The Installation Type screen is opened.
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4. Select the WebLogic Server Installation and click Next.

The Prerequisite Checks screen is opened.
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5. If issues are listed, they need to be resolved first before continuing with the next step.

6. Click Next.

The Specify Security Updates screen appears.
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Here you can enter your My Oracle Support account information to receive the latest 
product information and security updates via your My Oracle Support account.

7. If you do not wish to register for security updates, or if you do not have a My Oracle 
Support account, then leave all the fields on this screen empty and click Next.

The following warning screen can be shown.

8. To confirm click Yes.

The Installation Summary screen is opened.
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9. Review the listed options and click Install.

The installation process begins.

10. When the installation completes, click Next.

The Installation Complete screen is opened.
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11. Uncheck Automatically Launch the Configuration Wizard and click Finish.

Install Weblogic Patch for Generic Platform

Further information and instructions about these Weblogic patches can be found in the 
respective Readme file from the Oracle Patches and Updates Support Website

? https://updates.oracle.com/Orion/Services/download?type=readme&aru=23189839

? https://updates.oracle.com/Orion/Services/download?type=readme&aru=22379215

Note: The Weblogic server 12.2.1.3.0 requires the following patches to be 
installed

? Patch 28186730: OPATCH 13.9.4.X UPGRADE FOR FMW/WLS 
12.2.1.3

? Patch 28298734: WLS PATCH SET UPDATE 12.2.1.3.181016
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Node Manager Configuration
After the completion of the installation process of the Oracle WebLogic Server, the Node 
Manager must be configured.

Agile e6.2.1.0 is using one Node Manager for every host.

Windows
The Windows Service for the Node Manager has to be created manually.

1. Set JAVA_HOME and WL_HOME

set JAVA_HOME=C:\Program Files\Java\jdk1.8.0_<update_number>

set WL_HOME=<ORACLE_HOME_FOR_WEBLOGIC>\wlserver

2. To create the Windows Service, execute the following command:

<ORACLE_HOME_FOR_WEBLOGIC>\wlserver\server\bin\installNodeMgrSvc.cmd

3. After Windows service created, please go to Services site, start node manager service.

UNIX
To start the Node Manager, execute the following commands:

cd <ORACLE_HOME_FOR_WEBLOGIC>/wlserver/server/bin
./startNodeManager.sh &

All Operating Systems

Production Certificate Setup
For information on configuring SSL for Node Manager in production environments, see chapter 
Adaptation to the Node Manager Configuration.

Demo Certificate Setup
1. The following directory has to be created:

<ORACLE_HOME_FOR_WEBLOGIC>/oracle_common/common/nodemanager/security

Note: The default setup of the Node Manager is not creating the required 
certificate. This has to be done manually.

Note: This requires a new property (KeyStores) in the 
nodemanager.properties file. See Reviewing nodemanager.properties

Note: Only when starting the Node Manager with a valid certificate the file 
nodemanager.properties will be created.

Note: This directory can be created if you start the Node Manager once. 
The Node Manager will not continue to run because the required certificate is 
not available at this point.
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2. To properly set up the PATH and CLASSPATH variables, run the following command:

?  Windows (from a command shell):

call <ORACLE_HOME_FOR_WEBLOGIC>\wlserver\server\bin\setWLSEnv.cmd

?  UNIX (with a /bin/sh shell):

. <ORACLE_HOME_FOR_WEBLOGIC>/wlserver/server/bin/setWLSEnv.sh

3. Create a new directory in which you execute the following two steps.

4. Generate a certificate and private key.

java utils.CertGen -keyfilepass DemoIdentityPassPhrase -certfile democert 
-keyfile demokey

5. Import the private key and certificate.

java utils.ImportPrivateKey -keystore DemoIdentity.jks -storepass 
DemoIdentityKeyStorePassPhrase -keyfile demokey -keyfilepass 
DemoIdentityPassPhrase -certfile democert.pem -keyfile demokey.pem -alias 
demoidentity

Caution: The dot and the space character (. ) in front of the UNIX 
command are required to source the environment in the current bourne shell.

Note: On UNIX, the above command has to be executed from a new 
bourne shell. This shell can be started with the following command:

/bin/sh

This new /bin/sh shell has to be used to execute the following two Java 
commands also.

Note: Please make sure the PATH and JAVA_HOME environment variable 
are set correctly.

Note:  If you use the Java 8 161 or higher, add the additional parameter 
-noskid. 

java utils.CertGen -keyfilepass DemoIdentityPassPhrase -certfile democert 
-keyfile demokey  -noskid

Note: By default, utils.CertGen will use the short host name as the owner 
CN value in the generated certificate. To use the fully qualified DN host 
name, add the -cn option to the above command and append the full-qualified 
DN host name after it. See the following example for the host with the name 
app.example.com:

java utils.CertGen -keyfilepass DemoIdentityPassPhrase -certfile democert 
-keyfile demokey -cn app.example.com
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6. Move the DemoIdentity.jks keystore to the following directory:

<ORACLE_HOME_FOR_WEBLOGIC>/oracle_common/common/nodemanager/security

Adaptation to the Node Manager Configuration
Now it will be possible to successfully start the Node Manager because of the valid Node 
Manager certificate.

Start the Node Manager. If you already used the Node Manager startup to create the security 
directory, this will be the second time the Node Manager will be started. This start will generate 
the nodemanager.properties file.

After the first successful startup of the Node Manager, it must be reconfigured. This 
configuration file will only be available after the first successful startup with a working Node 
Manager certificate.

1. Open the following file with an editor:

<ORACLE_HOME_FOR_WEBLOGIC>/oracle_
common/common/nodemanager/nodemanager.properties

2. Modify the following properties:

SecureListener=false
ListenAddress=127.0.0.1
CrashRecoveryEnabled=true

3. After the changes, restart the Node Manager.

Note: The DemoIdentity.jks keystore now contains one private key and 
certificate entry. The other files can be deleted.
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9Verifying the Installation on UNIX

The following instruction can be used to verify the complete Agile e6 installation on UNIX.

1. After the Agile e6 application installation, the processes (daemons) listed below should be 
running on the server machine.

ps -ef | grep <installation name>
The exact values depend on the installation, but in general, the following processes have to 
be available:

?  Java Wrapper for Java Daemon

?  Java Daemon

?  Java Wrapper for FMS Java Daemon

?  FMS Java Daemon

?  Java Wrapper for Apache Tomcat

?  Apache Tomcat

2. Start the processes manually.

If you want to start the Agile e6 processes manually, execute the following commands:

?  Java Daemon:

cd ${ep_root}/axalant/scripts
./jade start

?  FMS Java Daemon:

cd ${ep_root}/axalant/scripts
./fms_jade start

Note: The database and application server processes should be running 
already.
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Note: On HP-UX the FMS Java Daemon must run with 32bit JRE. To 
switch from 64bit to 32bit the following two files must be adapted after the 
installation. 

? ${ep_root}/axalant/scripts/fms_jade

The following line must be changed:

EP_MACH_64=`env FORCE_64BIT_EP_MACH=true ${EP_
ROOT}/axalant/scripts/ep_get_mach`

to

EP_MACH_64=`${EP_ROOT}/axalant/scripts/ep_get_mach`

? ${ep_root}/axalant/ini/fms_jade_wrapper.conf

Comment out the following line:

wrapper.java.additional.1=-d64
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10Uninstalling

EDM Server
1. Start the Agile e6 Installer

?  Windows

1. Open a command shell.

2. Change to the installer directory:

set JAVA_HOME=C:\Program Files\Java\jdk1.8.0_<update_number>
cd <installation-media-path>\installer

3. Enter the following command:

gui.cmd
? UNIX

1. Open a command shell.

2. Change to the installer directory:

setenv JAVA_HOME /usr/local/java/jdk1.8.0_<update_number>
cd <installation-media-path>/installer

3. Enter the following command:

./gui.csh

The Installation Sets screen is opened.

Note: On UNIX, all Agile e6 services (File server, Java daemon) need to be 
stopped before uninstalling.
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2. Select Agile e6 Server and click Next.

The Installation Mode screen is opened.
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3. Select Remove Installation and click Next.

4. Select the name of the installation to be deleted.

5. To remove the installer and the Administration client, enter the following:

?  Windows

cd %ALLUSERSPROFILE%\agile\installer\6.2.1\admin\apache-tomcat\bin
net stop "AgilePLM_AdminClient"
service.bat remove AgilePLM_AdminClient

delete the directory "%ALLUSERSPROFILE%\agile\installer\6.2.1"

?  UNIX

su - <your e61 installation user>
cd .agile/installer/6.2.1/admin/apache-tomcat/bin
./shutdown
cd $HOME
rm -r .agile/installer/6.2.1

If the Agile e6.2.1.0 installation is removed from the server, the directory can be 
deleted. All components of the installation are removed.

Oracle Database

Note: All parts of the installation will be removed. The installation 
directory will be renamed. It can be deleted if it is not used.

Note: The installer and the Administration client are not removed.

Note: The WebLogic domains which were created are not removed.

Note: All installer information is removed after this task.

Note: It is not possible to uninstall Oracle 12c database with Oracle 
Universal Installer shipped with 11gR1, or an earlier version. Oracle 12c 
comes with a de-installation utility.

Note: If you have an improper Oracle installation, a second installation will 
fail. You have to uninstall Oracle and then try again.

Note: For uninstalling the Oracle installation, use the provided 
de-installation tool. Make sure the de-installation was done correctly before 
trying to reinstall Oracle.
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Windows

1. Open an Administrative command shell but to not change to the installer directory.

2. To uninstall Oracle 12c, start the following script:

%ORACLE_HOME%\deinstall\deinstall.bat
3. Specify all single instance listeners that are to be de-configured, as well as database names 

that are configured in this Oracle Home.

4. Confirm the de-installation with 'y'.

The %ORACLE_HOME% directory will be deleted after de-installation.

UNIX

1. Open a shell as the User which installed the Database.

2. To uninstall Oracle 12c, start the following script:

${ORACLE_HOME}/deinstall/deinstall
3. Specify all single instance listeners that are to be de-configured, as well as database names 

that are configured in this Oracle Home.

4. Confirm the de-installation with 'y'.

The ${ORACLE_HOME} directory will be deleted after de-installation.

Oracle WebLogic Server
To deinstall the Oracle WebLogic Server, refer to "Oracle Fusion Middleware Documentation 
at https://docs.oracle.com/en/middleware/fusion-middleware/index.html

https://docs.oracle.com/en/middleware/index.html
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